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Installing Event Review
You can install HeartStart Event Review 4.2 as a new installation,by itself or
coexisting with Event Review 3.5. If you install Event Review as a new installation,
you can install and run the new version for 60 days while you purchase a license.
Event Review stops working if you do not activate the software within 60 days of
installation.

You can install Event Review on the same computer as Event Review 3.5. Event
Review does not remove Event Review 3.5. You canmigrate case data from any
earlier versions after installation.

• For full details about hardware and software requirements, see System
requirements on page.7.

• For help with downloading and installing, see Downloading the application on
page.10.

• For help with installing, see The installation procedure on page.12.

• For help with migrating data from an earlier version of the software to the current
version, seeMigrating cases from previous versions on page.115.

System requirements
Event Review operates on a computer running either theMicrosoft® Windows XP™
orMicrosoft® Windows 7™ operating system. Make sure that any hardware you
choose is certified as Microsoft® - compatible.

Philips provides only the Event Review software. The software and hardware listed
in the following table are provided by the customer, unless noted.

This table has the following sections:

• Software requirements

• Hardware requirements

• Accessories

7
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Software requirements table

Component Requirement

Operating
system

Microsoft Windows XP Professional SP 3, or Microsoft Windows
XP tablet Edition SP3

Microsoft Windows 7

Microsoft Windows® Server® 2008 R2, 2008, 2003 R2, or 2003
for a remote server running the shared database

Database Microsoft SQL Server 2008 R2, 2008, or 2005

Hardware requirements table

Component Requirements

Processor speed Minimum: 1 GHZ

Recommended: 2 GHZ core duo or higher

Display Minimum: 1024 x 768

Recommended: 1400 x 1050 or higher

Video memory Minimum: 64 MB video memory

Recommended: 256 MB video memory

Memory Minimum: 1 GB

Recommended: 2 GB or higher

Disk space Minimum:

2 GB of disk space

Recommended: 5 GB of disk space

Hard-disk space requirements vary depending on usage and
defibrillator type. Variables affecting disk-space requirements
include the number of cases archived and the amount of audio
information archived. For example, a 15-minute FR2 ECG with
no audio is approximately 100 KB. The same ECG with audio
can exceed 5 MB. An ECG and audio from a HeartStart MRx
defibrillator can be as large as 256 MB.

1 - Installing Event Review Event Review User Guide
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Component Requirements

Internet
connection

Required to activate the application software, to use the Email
feature, and to receive software updates.

Accessories table

Component Requirement

Printer To print reports

Preferred: Color printer

PDF Reader To view HeartStart Event Review user guide

Recommended: Adobe Reader, latest version. For more
information, see the following Web site: http://get.adobe.com/reader

Backup and
restore tool

To help prevent data loss and corruption

Connection to
a time server

To synchronize your computer date and time

Note: If you use a time server, do not alter your system clock
manually.

Email
application

To activate the software by email or to send cases using email, and
to configure a MAPI-compliant email client

Spreadsheet
application

To display Q-CPR data in charts; data is exported in .xls format only

Sound card
and speaker

To play audio from the defibrillator

Card reader To read information from a defibrillator, see your Philips customer
representative to purchase the appropriate card reader.

See Selecting accessories for data transfer on page.100 for a
summary of the major card reader types.

IrDA support Required to read information from an HS1 or FRx defibrillator

Your computer must support the following technology:

• IrDA functionality

• An infrared transceiver or an infrared adapter

The transceiver will appear as a small, dark red or black window on
the computer and device.

1 - Installing Event Review Event Review User Guide
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Component Requirement

Bluetooth
adapter

To transfer HeartStart MRx and HeartStart FR3 data to your
computer

Bluetooth stack You can use Bluetooth to transfer MRx or FR3 data from the
defibrillator to your computer.

Bluetooth version: 2.0 or higher

You must have a supported adapter for Bluetooth
transmission.Most Bluetooth adapters, such as IO Gear
GBU421) are suitable. You can order an adapter from your
Philips representative.

The Bluetooth protocol varies depending on your Philips
defibrillator. It becomes more complicated as the Bluetooth stacks
from different vendors implement different subsets of the protocols.

• If you are working with both the MRx and the FR3, the
Widcomm stack currently can support both at the same time.

• If you are working only with the FR3, the Windows built-in
Microsoft stack is the preferred stack and provides the best
performance.

• If you are working only with the MRx, many other stacks( such
as the Toshiba stack that comes with the Panasonic
Toughbook) work well, in addition to the Widcomm stack.
Consult the MRx documentation for information on other
supported stacks. One notable exception is the Microsoft stack,
which does not have the protocol implementation that can
support the MRx.

The Bluetooth stack requirement dictates the Bluetooth
transceiver/dongle that you should use.

Downloading the application
You can download and use Event Review on a trial basis for 60 days before
purchasing and activating the software.

Use the authorization that you receive from your sales representative to download
the application from the Internet. Save the application file to your computer.You can
use the application on a trial basis and activate the software later.

1 - Installing Event Review Event Review User Guide
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To download the application

1. Start Windows.

2. Start Internet Explorer.

3. Navigate to the URL provided on your Proof of Purchase Certificate or by your
sales representative.

4. On the left pane, select the product.

5. On the right pane, click the link in Software Download. Navigate to the download
link.

6. Save the installation file to your computer.

For information on possible updates to the application, see Checking for updates on
page.11.

For instructions on installation, see The installation procedure on page.12.

Checking for updates

You can check at any time to see if new updates have been released for Event
Review.

Before you install any software updates on the computer, make sure that you
haveWindows Administrator privileges for the computer.

To check for updates

1. On the Helpmenu, click Check for Updates.

The application connects to theWeb site.

2. Click Show Updates.

TheWeb site displays a list of available updates. If a new update is available,
follow the rest of this procedure to download and install it.

3. Click Get Update for the Application.

4. Click Download and follow the instructions to save the update.

5. Note the name and location of the saved download file and follow the
instructions to install it.

6. When the file finishes installing, close the window.

7. Close the older version of the application.

1 - Installing Event Review Event Review User Guide
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The installation procedure
Once you have saved the installation file to your computer (see Downloading the
application on page.10), follow these instructions.

To install Event Review

1. In the folder where the installation file has been saved, double-click the file.

Youmay see a User Account Control box that asks you to authorize this
program tomake changes. Click Yes.

2. The Install Shield wizard checks for your database and for versions of the
Microsoft .NET Framework. If it needs to install or upgrade either of these, it
does so. Follow any instructions during this process (which can take some
time); if the User Account Control box asks you to authorize this program to
make changes, click Yes.

3. The Install Shield wizard dialog box is now ready to begin installation of Event
Review. Click Install.

4. On theWelcome screen, click Next.

5. On the next page, click I Accept the Terms.... and click Next.

6. The next page displays the current readme file, containing any late-breaking
information. When you have read this, click Next.

7. In the Custom Setup dialog box, you have the opportunity to save Event Review
in a different location from the default. If you need to check this new location for
available space, click the Space button. If you want to choose a different
location, click Change and navigate to the new location. When you are finished,
or if you want to accept the default location, click Next.

8. Confirm that you want to continue install; click Install.

9. When the installation is finished, click Finish.

10. An entry for Event Review now appears on the Start menu. See Starting the
application on page.22.

Activating the software
After you install the software, activate the product.

1 - Installing Event Review Event Review User Guide
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You can use the Internet or email to activate the software at any time after you install
the application. Until you complete the activation, you will see the Philips HeartStart
ActivationWizard window when the application starts, At the end of 60 days,
however, if you have not yet activated, you cannot run the application on this
computer

You can view the serial number by clicking the Helpmenu and clicking About Event
Review. In addition, save the serial number in a safe place that you can access in
case you need to re-install the software.

Email activation support is available in English only at:
activation.support@philips.com

Product support via email is available in English only at:
eventreview.support@philips.com

For complete information on customer support, see Customer support on page.94.

For telephone support in English only, call the following numbers between 9:00 AM
and 5:00 PM, Pacific Time:

• (800) 263-3342, inside the United States

• +1.978.659-3332, outside the United States

Activate over the Internet

You can activate the software by the Internet at any point when you first install the
application, preferably within 60 days of installation.

At the end of the 60 days, however, if you have not yet activated, you cannot run the
application on this computer

The activation wizard sends encoded information to the Philips server to validate
that the serial number you enter has not already been used for the allowed number of
installations and to activate your software. If you are not connected to the Internet,
the wizard alerts you that there is no connection.

To activate the software by the Internet

1. Start the application.

The application opens HeartStart ActivationWizard.

2. Type the serial number that you received.

3. Click I want to activate the software over the Internet.

1 - Installing Event Review Event Review User Guide
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4. Click Activate.

The wizard starts the application.

Activate by email

You can request to activate the software by email at any time after you first install
the application—preferably within 60 days of installation. When you use the
activation wizard, it attaches an encrypted file when it sends the activation request.
Customer Support sends you the activation code.

An email applicationmust be installed on this computer, or youmust have access to
an installed email application. You can continue to use the software for up to 60 days
before you complete the activation. At the end of the 60 days, however, if you have
not yet activated, you cannot run the application on this computer.

If an email application is not installed on this computer, contact Customer Support.

Email activation support is available in English only at:
activation.support@philips.com

Product support via email is available in English only at:
eventreview.support@philips.com

For complete information on customer support, see Customer support on page.94.

For telephone support in English only, call the following numbers between 9:00 AM
and 5:00 PM, Pacific Time:

• (800) 263-3342, inside the United States

• +1.978.659-3332, outside the United States

The ActivationWizard online Help includes the steps on how to activate the
software by email. Print the Help for future use.

The ActivationWizard online Help includes the steps on how to activate the
software by email. Print the Help for future use.

To activate the software by email

1. Start the application.

The application opens HeartStart ActivationWizard.

2. Type the serial number that you received.

3. Click I want to activate the software by email.

1 - Installing Event Review Event Review User Guide
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4. Click Next.

5. Click Request Activation Code to open your email application with a pre-
addressed email activation request.

6. Click Send.

Customer Support will send you an email with the activation code.

When you receive an email from Customer Support, complete the following:

1. Start the application.

The application opens the HeartStart ActivationWizard.

2. Verify or type the serial number that you received.

3. Click I want to activate the software by email.

4. Click Next to access the Activate by Email page.

5. Type the activation code in the Enter your activation code here field.

6. Click Activate.

The wizard validates your entry and displays a congratulations message.

7. Click OK.

The wizard starts the application.

Activate later

If you do not want to activate your copy of the application when you start it, you can
activate the software at any time when you start the application. At the end of the 60
days, however, if you have not yet activated, you cannot run the application on this
computer.

During the 60 days, you can use the application and save your work.

Until you activate the software, you will see the HeartStart ActivationWizard
window each time that you start the application.

To use the application without activating the software

1. Start the application.

2. When HeartStart ActivationWizard opens, click Skip.

The wizard starts the application.

1 - Installing Event Review Event Review User Guide
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Registering the application
You can register your copy of the application using the Internet. Registration is
optional and is not the same as the activation, which is required.

To register the software

1. Start Windows.

2. Start Internet Explorer.

3. Navigate to the following URL

http://www.philips.com/software_registration

4. Click a language.

5. On the language page, click the product.

6. Complete the registration form.

Uninstalling Event Review
If you need to remove the application, in theWindows Control Panel, click
Programs and then Uninstall a Program (Windows 7) or click Add/Remove
Programs (Windows XP). Then click the name of the application.

If you have an active Internet connection at the time you remove the application, the
removal process contacts the Philips activation server and releases your serial
number for installation on another computer. The removal process does not remove
the application database.

If you had Event Review 3.5 installed and do not want to run both versions on
the samemachine, youmust manually uninstall it.

Product compatibility
You can install HeartStart Event Review 4.2 on the same computer as Event
Review 3.5. Event Review does not remove Event Review 3.5.

1 - Installing Event Review Event Review User Guide
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You canmigrate the Event Review 3.5 data to Event Review 4.2 after installing
HeartStart Event Review 4.2. If you have a version of Event Review before 3.5, you
must upgrade to 3.5 first, andmigrate all the data, before upgrading to 4.2. For more
information, seeManaging the database on page.115.

1 - Installing Event Review Event Review User Guide
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Getting started
In Event Review, a "case" consists of all the information relating to a specific
cardiac emergency. This includes information recorded by supported defibrillators as
well as information entered by the device user. Event Review creates a case by
downloading ECG information, shock decisions, and any recorded audio from
Philips defibrillators. You can add details to the case as well.

Intended use 
HeartStart Event Review captures, reports, andmanages cardiac arrest information.
Event Review has tools for collecting and analyzing information, reviewing cases,
identifying trends, and evaluating the emergency response. All information relating to
a specific cardiac emergency is created in a case by downloading ECG information,
shock decisions, and recorded audio from Philips and Laerdal automated external
defibrillators (AED). Event Review also allows users to annotate case details.

What’s new in this release
Event Review 4.2 provides the following new features:

• Support for the Philips HeartStart FR3 defibrillator.

• Support for the Philips HeartStart MRx monitor/defibrillator, version F.02/R.02

• Support for the Philips HeartStart XL+ defibrillator

• Upgraded database support: SQL Express 2008 R2

• Improved waveform display: All ECGwaveforms are now rendered with a
uniform scale (initially, +/-2mV (1mV/cm). This removes themisperception that
the ECG signal amplitude changed, when only the rendering scale recorded by
the device changed. Furthermore, Event Review can now display many
segments as longer, contiguous segments.

• Support forWindows 7 64-bit as well as 32-bit.
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• Multiple file import/export: When you import data, you can choosemultiple files.
Each file is imported to a separate new case. You can also choosemultiple
cases and export them, and the case IDs will be used to keep their names
unique.

• Customer support for device history data via email from FRx, HS1, FR2, and
FR3 defibrillators. You can send the data file to Philips Customer Support for
assistance.

In addition, the User Account administration feature (including logon and logoff) and
the ECG Views feature have been removed.

Any late-breaking news on features is in the ReadMe document, available from the
Helpmenu.

Getting assistance
Event Review offers the following sources of help.

Application tooltips

When you hover the cursor over a toolbar button or event on the ECGwaveform, text
appears in a pop-up window. The text identifies the toolbar button and describes the
event.

Wizards

A wizard guides you through common tasks.

The wizard that is available on the Getting Started navigation pane and File menu
guides you through creating a case.

The IrDA wizard is available from the Attach ECGwindow in Cases. This wizard
guides you through the process that downloads and attaches ECG information using
the infrared transfer method.

Event Review essentials

This document, in PDF format, is designed for new users, It focuses on the simplest
andmost commonworkflows: adding and documenting a case, reviewing a case,
generating reports, and sending reports to other medical personnel. It includes only
basic procedures to accomplish these tasks. To see this document, on the Help
menu, click Event Review Essentials.

2 - Getting started Event Review User Guide
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Online help

To get help with the current feature, press F1.

To read an overview of a topic, on the Helpmenu, click Help . Select a topic from
Help Contents. You can use the browse buttons tomove from topic to topic.

User guide

The printable user guide, which includes all the information in the online Help
system, is in Portable Document Format (PDF). You can view it using a PDF reader
such as Adobe Acrobat.

You can view the user guide online, print sections, or print the whole guide.

For customer support, see Customer support on page.94.

Conventions used in this guide
This document uses the following conventions to help identify information.

Conventions Used for Example

Bold Menu options, buttons, field
names, and list box names
that you need to click.

On the File menu, click Import.

Italic Manual names. Instructions for administrator's guide.

Screen
message

To distinguish defibrillator
voice prompts and
HeartStart FR3 screen
messages from general text.

The defibrillator voice prompt
announces Administration

Press the center soft key (soft key #2).
The screen message reads Ready for
Data Transfer

Italics with
leading period

File extension types. The configuration is exported as an
.xml file.

Lower-case
italics

Specific file names. Name the configuration file
sample.xml.

Italics Variables and placeholders The default folder is located at
C:\Document and Settings\user
name\My Documents.

2 - Getting started Event Review User Guide
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A yellow box with a triangular caution icon and exclamationmark identifies
circumstances that can result in data corruption or information loss.

A blue box with a note icon contains information on how features are used.

A green box with a light bulb tip icon contains information to complete a task.

Using online help

Use online help system to search for information using the full-text search feature,
glossary, or an index.

You can access online help in these ways::

• Press F1 to open online help for the selected feature.

• On the Helpmenu, click Event Review Help.

2 - Getting started Event Review User Guide



3

Starting the application
Event Review does not place an icon on the desktop. To start Event Review, use
the shortcut on the Start menu or the All Programs menu.

To start Event Review

1. Click theWindows Start button.

2. Click All Programs.

3. Click Philips HeartStart Event Review 4.2.

You can also start Event Review directly from a .cod or .mic file. Navigate to the
folder containing the .cod or .mic file, and double-click the file.

To use Event Review, click a navigation button on the left pane of the application
window.

Understanding the application window
When you start Event Review, the Getting Started pane is above the navigation
buttons on the left. A welcome page is on the right. TheGetting Started pane helps
you to start working in the application.

Menu options and toolbar buttons change based on the navigation button and
functions that you select.

• Themenus list options to access the application features.

• The toolbar buttons provide quick access to frequently usedmenu options.

Beneath themenus and toolbar buttons, the navigation pane is on the left and the
workspace is on the right.

• The navigation pane has navigation buttons and a pane above the buttons.

• A navigation button groups major application tasks by their function. You can
hide or display navigation buttons.

• A navigation pane is above the navigation buttons. The pane lists navigation
tasks.
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The workspace on the right pane changes based on the navigation button and the
task that you select. For example, if you click Cases, and then click the All
Records navigation tool, all the cases stored in the database appear in the
workspace. When you double-click a row on the workspace,the details of the case
appear for viewing or editing.

The following illustration shows a typical Cases tab.

Key to illustration numbers

1 The title bar displays the product name and software version.

2 The toolbarprovides quick access to frequently used actions that you can
perform for the selected workspace, as represented by icons.

3 The menu bar displays the following menus: File, Edit, View, Tools, and
Help. Use the menu bar to select the actions that you want to perform.

4 The navigation pane lists tasks that you can perform in the workspace. The
pane content changes depending on which button is clicked and the
workspace that is active.

5 Use the navigation buttons in the navigation pane to move among the
workspaces.

3 - Starting the application Event Review User Guide
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Using the application tables and logs
In Cases,Administration, and Defibrillators, information appears in tables and logs to
help youmanage your data.

Each row represents one record in the database. A record can be a case, an event,
an attachment, or a system activity. Each column has values for a specific field.

You canmodify your view of the information by grouping and sorting the rows. You
can also print a table or log from the File menu or toolbar; click Print, then Table, and
then the table or log.

All Records table

The All Records table (in the Cases workspace) lists each case in the Event Review
database. The cases show the reference ID, case ID, patient ID, case date and
time, and patient name.

You can use the All Records table to do the following tasks:

• Sort and group cases. See Sorting and grouping cases on page.44.

• Search for cases based on a variety of values. For more information, see
Filtering entries on page.89.

• Hide or display columns. SeeWorking with columns on page.88.

• Open and delete cases. For more information, see Displaying case details on
page.43 and Deleting cases on page.50.

• View and print reports. For more information, seeWorking with reports on
page.81.

Once you open a case, you see a set of screen tabs with case details. Select a tab
to view, modify, and delete the information. You can use the case tabs in any order
based on your tasks within your organization.

Event Log

The Event Log is one of the tabs for a selected case. It lists all defibrillator events
and notes written for that case.

3 - Starting the application Event Review User Guide
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Once you open a case and select the Event Log tab, you can see details for an
event. You can sort, group, and filter the defibrillator events and notes that a
responder or reviewer added to the case. You can also print the events for the open
case.

For more information, see Reviewing case events on page.76.

Attachments table

The Attachments table, in the Cases workspace, lists each file that is attached to
the case. It identifies each attachment by the file name, file type, and date that the
file was attached. Use the Attachments tab tomanage the files that you attach to
the open case.

Once you open a case and click the Attachments tab, you can add and delete an
attached file. You can also sort, group, and filter the list of attached files.

For more information, see Attaching (adding) files to a case on page.78.

System Log

The System Log table identifies all system activities based on the type, action,
description, date and time, and the user name. The System Log table is on the
Administration workspace.

For more information, seeWorking with the System Log on page.87.

Completing fields
Use a pointing device, such as amouse or stylus, to select field values from a
window and to change the way information on tables and logs appears.

In Cases, when you use themouse to click or point to a field, a menu with options for
that field might appear.

• If check boxes appear to the left of the options, you can select multiple options
for the field.

• If check boxes do not appear to the left of the options, you can select only one
option for the field.

• If an option is a text box, type or write the information using your keyboard or
stylus.

• If you want to remove the selected option, click Clear.
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• If a menu does not appear, type or write the information using the keyboard or
stylus.

Resizing panes and workspaces
You can change the default layout of the application window. The revised layout
persists the next time you use the navigation pane or workspace.

To resize a pane or workspace

1. Use themouse to click and hold a border on the pane that you want to resize.

2. Drag the border in the appropriate direction to a new location.

The size of the adjacent panes adjusts.

Using a Tablet PC
You can also work in Event Review using a Tablet PC. Use the stylus in the same
way as you would use amouse or pointing device. You can also use the stylus with
the Tablet PC Input Panel to enter text.

To complete a text entry field in tablet mode

1. Use the stylus to tap a field.

The tablet displays a floating icon.

2. Tap the icon to display the Tablet PC Input Panel.

3. Click one of the following threemodes to enter the information:

• Writing pad
• Character pad
• On-screen keyboard

4. Type the information. For more information, click the Help icon on the input
panel.

5. Click Insert or tap the Enter key on the input panel.

Saving your work
Philips recommends that you save your modified patient details periodically. To

save your work, on the File menu or toolbar, click Save .
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Managing mouse behavior
If you work on a personal computer, you can change themouse to behave like a
stylus. This is useful when your mouse tends to change its location after you remove
your hand from themouse.

To change themouse behavior, on the Tools menu, click Options, and then click
Click Mode. (This used to be called Tablet mode.)

In Click mode, youmust first point and click the field, and then click the value. In the
standardmode, you can point or click the field plus its value at the same time.

Restoring confirmation messages
A confirmationmessage does one of two things:

• Informs you that an actionmight result in a change to a configuration

• Warns you that an actionmay cause a permanent change.

By default, confirmationmessages are enabled.

If you have disabled confirmationmessages (by checking the DoNot Show This
Message Again box when such amessage appears), you can re-enable them at any
point.

To restore confirmationmessages, on the Tools menu, click Options, and then
Restore Confirmations.

Using the Navigation pane
The navigation pane on the left of the Event Review display provides access to the
application tasks.

To display a set of tasks, click a navigation button.

Following is a description of the navigation buttons.
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• Cases has tasks to work with defibrillator patient data. It includes tools to
download patient data from a supported defibrillator. It can also import it from a
file that was previously downloaded by another HeartStart product such as Data
Messenger. Use Cases to record information such as patient demographics,
initial treatment, and outcome. You can also add comments to clarify a
defibrillator event or treatment. Responders and themedical staff can add notes
on the case.

• Administration helps the system administrator monitor and troubleshoot
system activity.

• Getting Started helps you create a case quickly, import an existing patient
case, and open a case already in your database.

You can hide the left navigation pane to increase the size of the workspace on
the right pane. You can always return to the navigation pane while you work on
the set of features.

To hide the navigation pane, at the top of the navigation, click the Auto Hide.
 icon.

The navigation pane disappears, and the Navigation Panel tab along the left edge of
the pane appears.

To display the navigation pane temporarily

1. Point to the tab along the left edge of the pane.

The navigation pane appears temporarily.

2. Point to or tap the right pane.

The navigation pane disappears.

3. Point to the tab again to redisplay the navigation pane.

To restore the navigation pane, click the tab, and then click the Stay Open. icon.
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Working with cases
The word "case" refers to all the information relating to a specific cardiac or
monitoring event. This includes information recorded by supported defibrillators and
information entered by a user. For information about supported defibrillators, see
Supported defibrillators on page.99.

The first step in working with ECG information (ECG) is to create a case. You can do
this in the following ways:

• Use the case wizard to download data from a defibrillator or its data card

• Import a case with an ECG from a .mic, .hic. or .cod file created by another
application, such as DataMessenger

.Mic files are created by the export function of products such as HeartStart Data
Messenger and Event Review.

.Hic files are created by third-party ePCR software using the Philips Software
Development Kit (SDK).

.Cod files are created by the export function of older products such as Review
Express Connect and Event Review 3.5.

• Create a case that does not have ECG information in it yet and add it later

Starting the cases feature

To create, review, andmanage cases, click the Cases navigation button.

On the Navigation Pane, the database records appear, and on workspace, the All
Records table appears.

For more information, see Displaying case details on page.43.

Understanding the Cases navigation pane
Use the Cases navigation pane to work with ECG information. You can complete
the following tasks in Cases:

• Download information from a supported defibrillator or its data card
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• Import information from a patient data file created by another HeartStart product,
such as DataMessenger

• Add information such as patient demographics, initial treatment, and notes to
clarify or comment on a defibrillator event

If you select information from a drop-down list, your choice persists the next time
you use the field. At that time, you can select another value.

Use the Database Records pane to access cases in the database.

Creating a case (including ECG) with the Case
Wizard

The wizard that is available on the Getting Started pane and the File menu guides
you through the steps required to add/download patient data from a defibrillator or its
data card, create a case, and complete some basic tasks.

After briefly displaying amessage listing the completed tasks, the wizard displays
the page for the next task.

To start the wizard

1. On the navigation pane, click the Getting Started navigation button.

2. On theGetting Started navigation pane, click Case Wizard.

3. In theWelcome Page window, click Next to continue.

The Attach ECG page appears.

Attaching (adding) an ECG

To attach an ECG from a Philips defibrillator or its data card

1. Use the table in Adding ECGs table on page.35 to identify themethod used to
add/download an ECG from your defibrillator.

2. Follow the instructions in Adding ECGs on page.34to attach the ECG.

3. Click Next.

The Case Summary page appears.

Entering case summary information

On the Case Summary page, you can handle case information three ways:
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• Add new information

• Accept the information that the defibrillator provides

• Override the information from the defibrillator

All information is saved to the database.

Different defibrillators may capture different patient information as part of
recorded ECG data. If you use data from the HeartStart MRx, the ECG
informationmight include patient information such as name, age, and gender.

To complete the Case Summary fields

1. Event Review completes the Case ID field. You can change the case ID.

For defibrillators that generate an incident ID, such as HeartStart MRx, the case
ID corresponds to this incident ID. Each device has its own system for
generating an ID.

2. Fill in the Patient ID, Last Name, and First Name fields.

3. In Reference ID, type a reference ID for the case that you can use to identify it
later. For example, "ER Room 3" or "Engine #3, Station 27". This information
may already appear if the case was imported from an application that provided it.

4. In Institution, type an institution name for the case. For example, "Valley
Hospital" or "District 5 Fire Department".

5. Click Next.

The Export Case page appears.

Exporting a file

You can export a case to a .mic file at any point. The file is then available to a
colleague who uses Event Review or . To create a file containing the ECG and case
information, check the Export to a File box and verify the file name and folder where
you want to save it.

If you want to password-protect the exported file, in the Password box, type the
password. Passwords can have nomore than 16 characters. They are case-
sensitive.

Remember to provide this password to anyone who needs to open the exported file.

If you need to remove patient identity, check the Remove Patient Identity box.

Click Next.
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Printing a report

You can print a case report at any point. If you want to print it as part of the Case
Wizard, check the Print a Report box, click the buttons for any available reports,
and click Next. The Email page opens.

Emailing case data

You can email a case at any point; the case is added to an email as a .mic file. If you
want to email it as part of the CaseWizard, check the Email Case box, type or click
the appropriate address or addresses, change the subject if you want, and type a
note to accompany the case if you want. You can also password-protect the file or
remove patient identify information.

Click Next. The Execute page opens.

Opening the case

At this point, you can specify that the case will open after all tasks are completed, so
that you canmake further changes and review them. Check the Open Case box
and click Finish. The status of each task within the CaseWizard displays in the
box.

If your email system needs verification before it can send the email, a confirmation
message appears. Click Allow, and the process continues.,

When the process is complete, click Exit. The case opens.

Creating a case
You can create a case , with or without ECG information.

To create a case that has ECG information

1. Use one of the followingmethods:

• Click the Getting Started navigation button, and then click Case Wizard.
• On the File menu, click Case Wizard.

The CaseWizard window opens. For more information, see Creating a case
(including ECG) with the CaseWizard on page.30.

2. Follow the on-screen instructions.
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To create a case that does not initially contain ECG information

1. On the File menu or toolbar, click New.

The tabs for the case in the workspace appear.

2. Complete fields to briefly describe or identify the case. For example, add the
case date and time, or select the site of collapse.

3. Click Save.

At a later time, you can open the case, attach ECG information, and complete
the tabs.

Importing case files
You can import one or more case files that were exported by another HeartStart
software application such as DataMessenger.

For each file you import, Event Review creates a case in the Event Review
database, adds the case to the All Records table, and adds the information from the
file to the case. You can use the file in the sameway as any other case you created.
You can save, modify, print, export, and email an imported file.

You can import using the Import option (available on the File menu and toolbar) or
using drag-and-dropmethods.

When you import a case file, Event Review imports all the details that were in
the case, such as patient demographics, responder and reviewer notes, and
physician notes. When you use the Attach ECG feature, Event Review
attaches only the ECG to the case.

To import files using drag and drop

1. On the navigation pane, click the Patient Cases navigation button.

2. Open the folder where your .mic., .hic, or .cod files are stored, and drag one or
more into the All Records table.

3. Event Review imports the cases, saves them to the database, and lists them on
the All Records table.

If any of the cases failed to import successfully (because they required a
password, for example), the outcome for each appears in the System Log. See
Working with the System Log on page.87.
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To import files using the Import option

1. On the navigation pane, click the Patient Cases navigation button.

2. On the File menu or toolbar, click Import.

The Import Case window opens.

3. Navigate to the folder that contains the files you want to import.

The list of files includes only those with a .cod, .hic, and .mic extension.

A .hic file is a defibrillator device file that is forwarded by an electronic patient
care record (ePCR) application or HeartStart DataMessenger.

4. If you want to import only one file, click it. If you want to import multiple files,
press CTRL and click each one. Click Open.

5. If any of the files were password-protected, type the file password in the
Password field before you attempt to open the file. Passwords can have up to 16
characters and are case sensitive. If some of the files are associated with a
different password, they will not import, and you will need to import them
separately with their own password.

6. Event Review imports the cases, saves them to the database, and lists them on
the All Records table.

If you were working with an open case when you importedmore than one case,
the last case in the list that you imported opens. If you were working in the All
Records table, the same table appears after the import.

If any of the cases failed to import successfully (because they had a different
password from the others, for example), the outcome for each appears in the
System Log. SeeWorking with the System Log on page.87.

Adding ECGs
"Attaching" an ECGmeans reading ECG information from a defibrillator
(downloading it), a defibrillator data card, or a file and adding it to a case.

You can attach an ECG to a case you are creating, or you can open an existing case
and attach an ECG to it. You can add extra ECGs from other defibrillators as well.
Depending on the defibrillator, you can attach an ECG information from a data card
or a file, or through a Bluetooth or an infrared transmission.

If you need help identifying the defibrillator or inserting a data card, seeWorking with
defibrillators on page.99.
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The defibrillator that you use determines themethod that you can use to attach an
ECG. The Attach ECGwindow lists the types of transfer methods that you can use
to attach an ECG on the left pane. The window lists data files in the right pane. The
data files include those that were transmitted or are stored on a removable device.

To display the Attach ECG window for an existing case

1. Click the Cases navigation button.

2. On the All Records table, double-click a case.

3. On the toolbar, click Attach ECG File.

Any time you have a case open for reviewing or editing, you can attach an
ECG. On the ECGmenu, click Attach, or on the toolbar, click Attach
ECG File.

Choosing a transfer method

Event Review activates the followingmethods automatically.( If you are transferring
data from theMRx, youmight have to click the Bluetooth icon the first time that you
use the feature.)

You can also click the following icons to attach ECG data.

• Bluetooth—begins the process of gaining access to ECG data fromMRx
and FR3 devices. When you click this icon, a wizard appears with instructions
for establishing bothMRx and FR3 connections. If you click MRx, you then
navigate to theMRx Bluetooth Exchange Folder that contains (or will
contain) the transmitted Bluetooth files. If you click FR3, a wizard appears with
instructions for how to put the FR3 into Administrationmode so that you can see
and download all available ECG files. (Youmight have to click the Bluetooth
icon the first time that you use the feature.)

•  IrDA—opens help on how to transmit data from HS1 and FRx defibrillators.

•  File System—displays the Open window that you can use to browse and
attach ECG information from a device's data card or your computer.

Adding ECGs table

Use the following table to identify themethod and instructions used to read and/or
download an ECG from a defibrillator.
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Defibrillator model Method used to read data Instructions

FR2 Series Card reader See Adding an ECG from a data card on
page.36.

FR3 Series Card reader
Bluetooth connection

See Adding an ECG from a data card on
page.36.
See Downloading an ECG using an FR3
Bluetooth transmission on page.38.

XL Card reader See Adding an ECG from a data card on
page.36.

XL+ USB data drive See Transferring XL+ data on page.108;

HeartStart MRx Card reader See Adding an ECG from a data card on
page.36.

HeartStart MRx HeartStart MRx, version
9.0 or later Bluetooth
connection

See Downloading an ECG using an MRx
Bluetooth transmission on page.38.

HeartStart FRx Infrared connection See Downloading an ECG from an
infrared connection on page.39.

HS1 family of
defibrillators,
including
HeartStart Home
and HeartStart
OnSite
Defibrillators

Infrared connection See Adding an ECG from a file on
page.40.

Imported case file File system See Adding an ECG from a file on
page.40.

Event Review documentation uses the HS1 or HS1 family of defibrillators to
refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1
Defibrillators.

If you need help identifying the defibrillator or using a transfer method, seeWorking
with defibrillators on page.99.

Adding an ECG from a data card

The FR2, FR3, XL, and HeartStart MRx defibrillators can use a data card to transfer
the recorded ECG and other data from the defibrillator to Event Review.

4 - Working with cases Event Review User Guide



37

To attach an ECG from a data card

1. Insert the data card into the card reader.

2. Use one of the followingmethods:

• On the ECGmenu, click Attach.
• On the toolbar, click Attach ECG File.

The Attach ECGwindow opens, listing ECG files grouped by the source of the
file.

3. On the right pane of the Attach ECGwindow, find the file that is associated with
the ECG information . Themedium for the data source appears under the Source
column.

4. (Optional for FR2 Series defibrillators) If the pediatric pads were used, choose
the FR2 Pediatric option. This allows Event Review to properly calculate the
pads impedance and the shock energy desired. If you have any doubt about
which pads the responder used, contact the responder.

Click the ECG you want to attach. In the Device column, right-click the FR2

icon and click FR2 Pediatric. The pink teddy bear  icon for FR2 Pediatric
appears.

5. Use one of the followingmethods:

• Click the file for the ECG you want to attach, and then click Open.
• Double-click the file for the ECG you want to attach.

Event Review downloads the file and attaches the ECG to the case. It appears
on the ECG tab.

Adding an ECG from a USB port

The HeartStart XL+ defibrillator uses a USB data drive to transfer the recorded ECG
from the defibrillator to Event Review.

To import data from the XL+ USB data drive to Event Review

1. Insert the XL+ USB data drive into the USB data port on the computer running
Event Review.

2. Ensure that Windows recognizes the XL+ USB data drive as a connected
device, and that Event Review is running.

Windows detects the USB data drive and begins transferring data. All XL+ data
is transferred to Event Review.
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3. When data transfer is completed, follow Windows procedures to safely remove
the XL+ USB data drive from your computer.

Downloading an ECG using an FR3 Bluetooth transmission

You can transfer files from the FR3 to the computer using Bluetooth transmission, if
the FR3 is equipped with Bluetooth capability.

To attach an ECG using a Bluetooth transmission

1. Set up the Bluetooth software and adapter on the computer. For information, see
your defibrillator documentation and Setting up Bluetooth transmissions for the
MRx and FR3 on page.103.

2. Prepare to send the Bluetooth transmission by placing the FR3 (turned on, after
the voice acknowledgment) into Administrationmode, pressing the option
button, and selectingWireless Data Transfer.

3. In Event Review, use one of the followingmethods:

• On the ECGmenu, click Attach.
• On the toolbar, click Attach ECG File.

4. On the right pane of the Attach ECGwindow, find the ECG recording that you
want to attach.

Themedium for the data source (in this case, Bluetooth) appears under the
Source column. Keep inmind that if your ECG recording is very long or contains
audio, it may take as long as 5 to 10minutes (or even longer) before it appears in
the window.

5. Use one of the followingmethods:

• Click the file for the ECG you want to attach, and then click Open.
• Double-click the file for the ECG you want to attach.

Event Review attaches the ECG to the case, and the ECG tab appears with the
attached ECGwaveform(s).

Downloading an ECG using an MRx Bluetooth transmission

Depending on the version of your MRx, and its options, you can transfer files from
theMRx to the computer using Bluetooth transmission.

To attach an ECG -using a Bluetooth transmission

1. Set up the Bluetooth software and adapter on the computer. For information, see
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your defibrillator documentation and Setting up Bluetooth transmissions for the
MRx and FR3 on page.103.

2. Send the Bluetooth transmission. For information, see Sending theMRx
Bluetooth transmission on page.106.

3. Use one of the followingmethods:

• On the ECGmenu, click Attach.
• On the toolbar, click Attach ECG File.

4. On the right pane of the Attach ECGwindow, find the file that is associated with
the ECG .

Themedium for the data source appears under the Source column.

5. Use one of the followingmethods:

• Click the file for the ECG you want to attach, and then click Open.
• Double-click the file for the ECG you want to attach.

Event Review attaches the ECG to the case.

6. If the file does not appear in the right pane, click Bluetooth on the left pane of
the Attach ECGwindow and use the BluetoothWizard to navigate to the
Windows Bluetooth Exchange Folder.

• On the Browse for Folder window, navigate to theWindows Bluetooth
Exchange Folder for the user. The default folder forWindows XP is
located at C:\Document and Settings\user name\My Documents\Bluetooth
Exchange Folder. The default folder forWindows 7 is located at
C:\Users\user name\My Documents.

• If you specified a different folder when setting up your Bluetooth stack or
Neighborhood, navigate to that folder.

• Event Review scans the location you specify to find the ECG. It enables the
Bluetooth icon to the right of the status bar while it reads the Bluetooth files.

7. One or more ECG tabs appear with the attached ECGwaveform(s).

If the ECG tab does not display an ECGwaveform, contact Customer Support.
See Customer support on page.94.

Downloading an ECG from an infrared connection

The HeartStart HS1 family of defibrillators and the FRx defibrillator use an IrDA
connection to attach an ECG to Event Review.
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To attach an ECG from an infrared connection

To retain the actual event times, do not remove the battery from HS1 or FRx
defibrillators. If you remove the battery before you download the case
information, the files created before you removed the battery might appear in
the list without a date and time (though they will show elapsed time for events
and ECG data when you open them). For information on HSI and FRx
defibrillators' case date and time, see Determining the HS1 and FRx case date
and time on page.109.

1. Set up the infrared connection between the defibrillator and the computer. For
more information, see Using infrared connections for the HS1 and FRx on
page.110.

2. Use one of the followingmethods:

• On the ECGmenu, click Attach.
• On the toolbar, click Attach ECG File.

3. Put the defibrillator in Administrationmode. For more information, see Setting up
the infrared connection on page.110.

4. (Optional) If you need help with setting up the IrDA handshake for HS1 or FRx
defibrillators, use the IrDA Wizard.

On the left pane of the Attach ECGwindow, click IrDA. . On the IrDA
Wizard window, follow the on-screen instructions. The IrDA icon to the right of
the status bar appears enabled while it transfers the data.

5. When the defibrillator connects, the voicemessage says Sending (for the HS1)
or Transferring data (for the FRx).

6. On the right pane of the Attach ECGwindow, find the file that contains the ECG.

The data source appears in the Source column.

7. Use one of the followingmethods:

• Click the file for the ECG you want to attach, and then click Open.
• Double-click the file for the ECG you want to attach.

Event Review downloads the file and attaches the ECG to the case.

8. A message appears requesting the case start time when the HS1 or FRx case
does not have a start time. Event Review requests the start time.

Adding an ECG from a file

When you attach an ECG from a file, the file can be on the hard drive, external
media, or the network.
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This might occur when a remote user downloads a case via another HeartStart
application, like DataMessenger, and saves it to a file for your subsequent use.

To attach an ECG from a file

1. Use one of the followingmethods:

• On the ECGmenu, click Attach ECG.
• On the toolbar, click Attach ECG File.

2. On the left pane of the Attach ECGwindow, click File System. .

TheOpen window lists file extensions in the Files of Type field.

3. In the Files of Type field, click the file type.

4. Click Device Data for files with the .s01, .index, .cod, .xml, or .mic extensions.

• Click FR2 Series Peds for files that were recorded using FR2 defibrillator
pediatric pads.

5. Navigate to the file you want and double-click it.

Event Review downloads the file and attaches the ECG to the case.

If the ECG tab does not display an ECGwaveform, contact Customer Support.
See Customer support on page.94.

After you add an ECG

After you attach the ECG information to a case, use the tabs on the Cases
workspace to add details to the case.

The following table lists common tasks and related instructions.

Task Topic

Add details to a case Adding case details on page.51

Save a case Saving cases on page.45

Export a case Exporting cases on page.47

Email a case Emailing a case on page.49
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Adding multiple ECGs
If the emergency response for a single patient involvedmultiple ECGs on supported
defibrillators, you can attach all ECG files to the same case. On the ECG tab, a tab
appears for each attached ECG. The tab text identifies the defibrillator, date, and
time transmitted by the defibrillator. For example: HeartStart MRx 3/10/2007 3:10:44
PM.

To attach the first ECG, follow the instructions in Adding ECGs on page.34.

To attach additional ECGs

1. Make sure that the case is open. For more information, see Displaying case
details on page.43.

2. Use one of the followingmethods:

• If you are attaching an ECG from anHS1 or FRx defibrillator, make sure
that the defibrillator is set up to communicate using an infrared connection.

• If you are attaching an ECG from a data card, insert the card into the card
reader.

• If you are attaching an ECG using a Bluetooth connection, make sure that
the defibrillator is set up for transmission.

3. Use one of the followingmethods:

• On the ECGmenu, click Attach.
• On the toolbar, click Attach ECG File.

4. On the right pane of the Attach ECGwindow, find the file that generated the
ECG.

Themedium for the data source appears in the Source column.

5. Use one of the followingmethods:

• Click the file for the ECG you want to attach, and then click Open.
• Double-click the file for the ECG you want to attach.

The ECG appears on a separate tab on the ECG tab.

Removing ECGs from a case
Use the Detach option, on the ECG menu and toolbar, to remove an ECG from the
case.

The ECGmenu is available when you open a case and work on the ECG table.
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To detach an ECG

1. Open the case in the Cases workspace.

For more information, see Displaying case details on page.43.

2. Click the ECG tab.

3. On the ECG tab, click the ECG ID tab for the ECG you want to detach.

4. Use one of the followingmethods:

• On the ECGmenu, click Detach.
• On the toolbar, click Detach ECG.

A confirmationmessagemight appear. For more information, see Restoring
confirmationmessages on page.27.

5. Click Yes to remove the ECG from the case.

Displaying case details
Use the table on the Cases workspace to display patient identifiers and case details.
The table lists each case in the database. The following appear for each case: the
reference ID, case ID, patient ID, date and time, patient name, and institution.

You can customize how the information appears. For more information, see
Working with columns on page.88 andGrouping and sorting entries on page.88.

Once you open a case, you select a tab to view andmodify the detailed information.
You can also view and print reports for the open case and export the open case to a
different location as a file.

To open a saved case

1. Click the Cases navigation button.

2. Use one of the followingmethods:

• On the All Records table, double-click the case you want to open.
• On the File menu or toolbar, click Open.

The case appears in the Cases workspace.
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Sorting and grouping cases
You can change the way information displays on the All Records table. You can sort
cases and group them based on a shared parameter value.

You can filter or select cases that meet the criteria you select. You can also hide or
display groups of cases.

For information on how to add columns to and delete columns from the display, see
Working with columns on page.88.

For information on how to group and sort information in columns, seeGrouping and
sorting entries on page.88.

For information on how to filter the information that appears in the list of cases, see
Filtering entries on page.89.

Hiding and displaying cases
You can hide or display the list of cases in the groups. You can also view and refresh
the list of cases from the View menu or shortcut menu on the All Records table. The
shortcut menu lists the Refresh, Expand All, and Collapse All options.

To use the shortcut menu

1. Open Patient Cases and then All Records. For more information, see
Displaying case details on page.43 .

2. Right-click the All Records table.

3. Click an option.

To refresh, hide, or display cases

• To refresh the list of cases, on the View menu or shortcut menu, click
Refresh.

• To hide cases in a group, click Collapse All to the left of the grouping.
• To hide cases in each group, on the View menu or shortcut menu, click

Collapse All.
• To display cases in a group, click Expand All to the left of the group.
• To display all cases in the table, on the View menu or shortcut menu, click

Expand All.
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Adjusting the date and time of the defibrillator
data

It is possible for the internal clock on your defibrillator to drift slightly over time. In
addition, if someone removed the battery from anHS1 or FRx defibrillator before
downloading the patient data,case and event real time could be lost, leaving only
event elapsed time. In these cases, youmay want to adjust the times of the
downloaded case and its individual events.

Before you transfer information from a defibrillator, confirm that your computer clock
is accurate. For example, if the computer does not connect to a time server, you can
compare the date and time with an atomic clock on the Internet. Also, confirm that
the battery was not pulled from the HS1 or FRx defibrillator since the cardiac
emergency. For information on HS1 and FRx defibrillators case date and time, see
Determining the HS1 and FRx case date and time on page.109.

To adjust the defibrillator date and time based on the computer date and time

1. Open the case in the Cases workspace. For more information, see Displaying
case details on page.43.

2. On theOverview tab, navigate to the Defibrillators area.

Confirm that the date and time for the defibrillator are correct in the Defibrillators
area.

If you transfer the case from a defibrillator through a Bluetooth transmission,
Event Review automatically adjusts the case event date on the received data
based on the computer clock.

3. After you attach an ECG, you can change the date and time for the appropriate
case in the Adjusted “On” Time column.

The date and time automatically adjusts for each event in that case. The ECG
tab displays the adjustment that you enter.

4. On the File menu or toolbar, click Save.

Saving cases
When you save a case, Event Review adds it to the database. All the information is
available for reports. Use the All Records table tomanage the case.
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To save an open case, on the File menu or toolbar, click Save. The case is now in
the Event Review database.

Erasing the data source
After you attach an ECG and save the case to the database, consider erasing the
data from the source. This ensures that the device has full capacity for the next use.

You can erase ECG information from the data cards used by theMRx, the FR2 and
FR3 series, and XL defibrillators. You can also erase the ECG information from an
HS1, XL+, or FRx defibrillator.

You can also use Bluetooth to erase files that were transmitted via Bluetooth from an
MRx.

Make sure that you transfer all the information to the database or an archive
before erasing the information. Once the data is erased, it is lost and cannot be
recovered.

To erase a data card

1. Insert the data card into the card reader.

2. On the Tools menu, click Erase Data on Card or Device.

The Erase Data on Card or Device window opens.

3. Click the card or device name.

4. Click Erase.

A confirmationmessagemight appear. For more information, see Restoring
confirmationmessages on page.27.

5. Click Yes in themessage box.

To erase data from an HS1 or FRx Defibrillator

1. Set up the defibrillator to communicate with Event Review Pro. For more
information, see Using infrared connections for the HS1 and FRx on page.110.

2. Put the defibrillator in the Administrationmode.

3. On the Tools menu, click Erase Data on Card or Device.

The Erase Data on Card or Device window opens.

4. Click the device name.

5. Click Erase.
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A confirmationmessagemight appear.

6. Click Yes in themessage box.

To erase data from the Bluetooth Exchange folder (MRx only)

1. On the Tools menu, click Erase Data on Card or Device.

The Erase Data on Card or Device window opens.

2. Click Bluetooth Exchange Folder.

3. Click Erase.

A confirmationmessagemight appear.

4. Click Yes.

To erase data from an FR3 defibrillator using Bluetooth

1. Once the unit is on and you have heard the voice prompt, place the FR3 in
Administrationmode, press the option button, and select Wireless Data
Transfer.

2. In Event Review, on the Tools menu, click Erase Data on Card or Device.

The Erase Data on Card or Device window opens.

3. In the Bluetooth section, click the FR3 icon whose serial numbermatches the
device that you want to erase.

4. Click Erase.

A confirmationmessagemight appear.

5. Click Yes.

The clock on the defibrillator is now synched with the clock on the computer.
This synchronization occurs even if you have no data to erase.

To erase data from a USB data drive

1. Use the XL+ defibrillator to erase data from the USB data drive. For more
information, see the HeartStart XL+ instructions for use.

Exporting cases
Use Export to create files outside the application (that is, not in the application
database) so that you can share information with other Event Review or Event
Review Pro users. You can also use Export to back up information.
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You can export a single case or multiple cases at a time. The Export option is
available on the File menu whenever the Cases list appears or a specific case is
open. In addition, if you want to export just one case, you can do this (from the File
menu or the toolbar) when that case is open.

You can export files with or without a password. If you add a password, anyone
attempting to open the file must have the password to open it.

Philips recommends that you record the password and save it in a secure
location. If you forget the password, Customer Support cannot “unlock” the file.

To export one or more case files from the Cases list

1. On the Navigation pane, click the Patient Cases navigation button.

All cases appear.

2. Choose the case or cases to export:

a. Click a single case.
b. CTRL-click multiple cases.

3. On the File menu, click Export.

The Export Selected Cases dialog box appears, showing the last folder you
used to export a file. If you want a different location, click the Save in field at the
top of the dialog box and navigate to that location. The list there shows
.mic.files, which is the only supported file format.

4. Decide how to name the exported file or files. The default name includes a
placeholder for the case ID, expressed as {caseID}. You can accept the case ID
as the filename, or you can use this placeholder to createmore descriptive
names; for example, if you type “my data {caseID} for Joe.mic” for the filename
and export two cases, one with a case ID of “abc” and one with “xyz,” then the
two .mic files will have the names “my data abc for Joe.mic” and “my data xyz
for Joe.mic.” If you type something entirely different for the name that doesn’t
include a case ID, the case ID will be appended to the filename by the software.

5. If you want to remove confidential patient identifiers such as name, patient ID,
and age (if over 90) from the exported file (called "redaction"), check the
Remove Patient Identity box.

6. Decide whether you want to protect the file or files with a password. If so, type it
in the Password field (for security, it appears as *****). Remember to provide
the password for the recipient.

7. Click Save.

A progress bar appears as the export operation proceeds, and a confirmation
message tells you that the export operation succeeded.
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To export a single case file from the case display

1. On the navigation pane, click the Patient Cases navigation button.

2. In the list of cases, click a case to open it.

3. On the File menu or toolbar, click Export.

4. Follow steps 3 through 7 in the procedure above.

Emailing a case
You can use the Email option or your email application to send an exported ECG or
an entire case to another Event Review user.

Event Review attaches the exported case file to the email when it displays the email
window.

Before you use the Email option, complete the following prerequisites:

• Correctly configureMicrosoft Outlook or aMAPI-compliant email client.
• Set up the email profile inWindows, if needed. Click Help on the email

profile window for information on setting up your profile. After you complete
the profile, the profile does not appear again.

To use the Email option

1. On the Cases workspace, display the case details. For more information, see
Displaying case details on page.43.

2. On the File menu or toolbar, click Email.

The Email window opens and attaches the file to the email form.

3. Complete the To field. The contact list for your email application is not available
for the Email tool.

Email saves the address. The next time you send an email to that recipient, you
can select the same address by clicking the arrow at the end of the To field.

4. If you want, add amessage.

5. Click Send.

To use your email application

1. Export the file. For more information, see Exporting cases on page.47.

2. Note the location of the exported file. The file has the supported extension.

3. Open your email application and create an email to the recipient of your choice.
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4. Attach the file created by Export in Step 1 to the email form.

5. Send the email.

Deleting cases
You can delete a case or multiple cases from the database. The case or cases then
disappear from the All Records table.

To delete a case or cases from the list of cases

1. Click the Patient Cases navigation button to start the Cases feature.

2. On the All Records table, click the case you want to delete, or press CTRL or
SHIFT while clicking to select multiple cases..

3. On the File menu or toolbar, click Delete. .

A confirmationmessagemight appear. For more information, see Restoring
confirmationmessages on page.27.

4. Click Yes.

To delete a case that is open

1. On the File menu or toolbar, click Delete. .

A confirmationmessagemight appear. For more information, see Restoring
confirmationmessages on page.27.

2. Click Yes.

The All Records table appears.
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Adding case details
Use the Patient Cases navigation button to access a case and enter case
information that the defibrillator did not record. In Cases, you can do the following
tasks:

• Document events

• Add responder actions and observations

• Add reviewer notes

• Review ECG information

• Review events

• Attach files to a case

For more information, seeWorking with ECGs on page.61 and Reviewing case
details on page.76. You can use the case tabs in any order based on your tasks
within your organization.

To add and review case details

1. Click the Patient Cases navigation button.

2. On the Cases workspace, double-click a case on the All Records table.

3. Click a tab.

4. Add or change information on the tab.

5. Repeat steps 3 and 4 as necessary.

6. On the File menu or toolbar, click Save.

Event Review displays case detail tabs based on your installation.

Identifying the case
Use theOverview tab to enter basic information about the patient and the response
location. The only required information is the case ID, and the case date and time.
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If you use the CaseWizard to create a case, Event Review assigns a case ID,
which you can change. It also generates the case ID from the current date and time
if CaseWizard or the Import feature did not create the case.

Different defibrillators may capture different patient information as part of
recorded ECG data. If you use data from the HeartStart MRx, the ECG
informationmight include patient information (such as name, age, and gender)
that was entered by the responder. When you import a case using Case
Wizard, the Case Summary page displays the information provided by the
MRx, and the Case ID field displays theMRx incident ID.

If you export a redacted case (that is, a case with patient identification removed),
Event Review replaces the name and patient ID with a series of asterisks. The Date
of Birth field is blank. If the redacted age of the patient is greater than 90, the Age
field displays 90. If you then import the case, the redacted information (the
information that was removed) does not appear.

After you attach the ECG, you can change any of the information except the
information in the following fields, which the defibrillator may supply:

• Recorded “On” Time

• Defibrillator Type

• Serial Number

• Shocks

To complete the fields

1. Click the field.

2. Click an option on themenu or type the information in the field.

If Other appears in the option list, you can type a value in the Other text box. If
your entry is the same as an option in the list, your entry appears as shown in
the option list. Click Clear to remove the information in the field or text box.

Overview section fields table

Group or field Description

Case ID

(Required)

When you attach an ECG, incident ID becomes the case ID. You
can change the case ID.

Time zone Initially, displays the time zone for the computer clock. The time
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Group or field Description

zone displays in the Coordinated Universal Time (UCT) or
Greenwich Mean Time (GMT) format in a similar format to the Time
Zone tab on the Windows Date and Time Properties window. For
example: (+1:00) Amsterdam, Berlin, Bern, Rome, Stockholm,
Vienna.

Select the time zone of the location where the incident occurred.

Case date and
time
(Required)

.If you attach an ECG before you save the case, this field is set to
the date and time when the device was turned on.

To change the date and time, click the value you want to change,
and then type a new value.

Site of collapse The list includes typical kinds of locations such as Ambulatory or
outpatient area, Hotel, Workplace, Adult intensive care unit (ICU),
and Cardiac catheterization lab (cath lab).

Location Detail You can use this field to be more specific about the site of collapse.
For example, consider using this field to record map coordinates or
the name of locations, such as the room number.

Reference ID You can use this field to help identify the case. For example, Engine
3.

Institution You can use this field to identify the organization where the case
originated. For example, Valley Fire Department.

Defibrillator section fields table

Group or field Description

Adjusted “On”

Time

You can use this field to synchronize the defibrillator-created date
and time with the computer date and time.

Event Review automatically adjusts the date and time of each event
on the ECG tab for the adjustment you enter.

Note: Event Review automatically adjusts the date and time based
on the clock of the personal computer when it receives a Bluetooth
transmission from a HeartStart MRx version 9.0 or later, or from an
FR3. This adjustment records the Recorded “On” Time. You can still
use this field to override the Recorded “On” Time.

Recorded “On”
Time

When you attach an ECG, the field displays the date and time that
the defibrillator was turned on.
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Group or field Description

HS1 and FRx only: If you removed the battery before the ECG was
attached (downloaded), Event Review displays a message
requesting the case date and time. When you click OK, you see this
screen:

Set the case date and time to the Recorded “On” Time of the ECG.

You can adjust the time in the Adjusted “On” Time field.

Debrillator
Type

When you attach an ECG, the field displays the defibrillator model
name.

You cannot change it.

Serial Number When you attach an ECG, the field displays the defibrillator serial
number.

You cannot change it.

Shocks When you attach an ECG, the field displays the total number of
shocks delivered to the patient by this defibrillator. You cannot
change it.

Patient section fields table

Group or field Description

Patient ID By default, the value in the Patient ID field is added based on the
patient ID from the defibrillator (if the device supports entering such
data). Otherwise, it is blank, and you can add an ID.

The patient ID prints in report headers.

A redacted case displays a series of asterisks for the patient name
and patient ID.
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Group or field Description

First name The first name prints in report headers.

If the ECG is from HeartStart MRx, this field can contain information
entered on the MRx. You can change it.

A redacted case displays a series of asterisks for the patient name
and patient ID.

Middle name The middle name prints in report headers.

A redacted case displays a series of asterisks for the patient Event
Review name and patient ID.

Last name The last name prints in report headers.

If the ECG is from HeartStart MRx, this field can contain information
entered on the MRx. You can change it.

A redacted case displays a series of asterisks for the patient name
and patient ID.

Date of birth Type the patient date of birth in the field.

A redacted case displays a blank field.

Age This is the age of the patient at the time of the response. Select the
format used and type the age in the field. The units of
measurements include years, months, or days You can change the
format at any time. Event Review calculates the new value for you.

If the ECG is attached from HeartStart MRx, this field might contain
information entered on the HeartStart MRx. You can change it.

If you import a redacted case and the age of the redacted patient is
greater than 90, the Age field displays 90.

If the date of birth is entered, age is computed automatically, and
you may not enter it.

Height This is the height of the patient.

Select the format used by the hospital and type the height in the
field. The units of measurement include feet (ft), inches (in),
centimeters (cm), or meters (m).

You can change the format at any time.

Weight This is the weight of the patient at the time of the response.
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Group or field Description

Select the format used by your organization and type the weight in
the field. The units of measurement include pounds (lb.), ounces
(oz.), kilograms (kg), or grams (g).

You can change the format at any time.

Gender The list is:

Female

Male

Unknown

If the ECG is from HeartStart MRx, this field might contain
information entered on the defibrillator.

Race The list is:

American Indian or Alaska Native

Asian or Pacific Islander

Black, Hispanic

Black, Non-Hispanic

White, Hispanic

White, Non-Hispanic

Unknown

Other

Describing the conditions at the scene
Use the Scene tab to enter the responder's initial impression of the patient and the
scene. The information on this tab appears in the Case Report.

To complete the fields

1. Click the field.

2. Click an option on themenu or type the information.

If Other appears in the option list, you can type a value in the Other text box. If
your entry is the same as an option in the list, your entry appears as shown in
the option list. Click Clear to remove the information in the field or text box.
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The Defibrillator Types Used field can accept more than one input.

Documenting events
Use the Timeline tab to document the events that occurred during the case, the
treatments that were administered, and the notes that were collected during the
case. The Timeline tab also lists the notes that you add to the ECG on the ECG tab.

Event Review sorts events for a new case in chronological order. You can sort
events in ascending (1 to 9, a to z) or descending (9 to 1, z to a) order.

Events and notes appear in the Event Report, on the ECG tab, and on the Event Log
tab.

If Other appears in the option list, you can type a value in the Other text box. If
your entry is the same as an option in the list, your entry appears as shown in
the option list. Click Clear to remove the information in the field or text box.

Events that you add on the ECG tab appear on the Timeline tab as read-only. You
can edit the Event Name parameters and the Comment fields, but not the Date and
Time field.

Adding, describing, and removing events

On the Timeline tab, you can record events that are time-specific for open cases.
The default event types are Estimated Collapse, Call Receipt, and BLS Arrival at
Patient. For each of these events, use the drop-downmenu in the Date and Time
column to choose the specific time; check the Unknown box if you do not have this
information. In the Comment box, type any extra information about the event.

You can also add, edit, and remove a custom event.

To add an event

1. On the Timeline tab, click the Event Name field.

A menu showing types of events appears.

2. Click an event from one of themenu columns.

Event Review adds the event to the table in chronological order.

• Click Responder note to document notes from a responder.
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• Click Reviewer note to document notes from amedical director, code team
leader, or operations manager.

• If the event displays additional fields, complete the appropriate information
for each field.

Event Review displays a button to the left of the event. Click the button to
collapse or expand the additional fields that document the event.

3. (Optional) Type text in the Comment field.

4. Repeat steps 1, 2, and 3 for each event, as necessary.

To edit an event

1. On the Timeline tab, click the appropriate event in the Event Name field.

2. Use one of the followingmethods:

• Select the appropriate option on themenu.
• Type the correction.

To remove one event

1. On the Timeline tab, click the Event Name field.

2. On themenu, click Remove this event.

The event disappears from the event table.

Hiding and displaying event details

You can hide or display the events details for the open case. For more information,
see Displaying case details on page.43.

• To refresh the list of cases, on the View menu or shortcut menu, click Refresh.

• To hide one event row, on the Timeline tab, click Collapse. to the left of the
Event Name field.

• To hide all event rows, on the View menu or shortcut menu, click Collapse All.
.

• To display one event row, on the Timeline tab, click Expand. to the left of
the Event Name field.

• To display all rows, on the View menu or shortcut menu, click Expand All. .
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Sorting events

You can sort the information based on the column. Events in a new case are first
sorted in chronological order.

Click the header to sort the list of values in ascending (1 to 9, or a to z) or descending
(9 to 1, or z to a) order. A triangular symbol (arrow) appears to indicate the sort order.

Event Review adds new events based on the sort order. The location of the
event field for the new event changes depending on the sort order. For
example, if you sort events in alphabetical order, Event Review inserts the
event alphabetically. The blank event field is at the top of the table. If you sort
the event by date and time in descending order, Event Review inserts the event
at the top of the table. The blank event field is at the bottom of the table.

Changing the date and time of the event

You can change the date and time of an event that you entered on the Timeline tab.

To change the event date and time

1. Click the event.

2. Click Date and Time.

3. Click the value you want to change and type the correct date or time.

Documenting the patient's outcome
Use theOutcome tab to enter information about the patient during and after
hospitalization.

To complete the fields

1. Click the field.

2. Click an option on themenu or type the information in the field.

If Other appears in the option list, you can type a value in the Other text box. If
your entry is the same as an option in the list, displays your entry as shown in
the option list. Click Clear to remove the information in the field or text box.
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Several fields use scores for Cerebral Performance Categories (CPC) andOverall
Performance Categories (OPC). For more information, see CPC andOPC on
page.118.
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Working with ECGs
Use the ECG tab in Cases to add, review, and print ECGwaveforms. You can also
use the ECG tab to enter information and review events.

You can complete the following tasks on the ECG tab:

• View an attached ECG

• Add notes to an ECG

• Modify the display properties of an ECG

The ECGwaveform includes recorded defibrillator events as well as reviewer and
responder notes. For information on attaching an ECG, see Adding ECGs on
page.34.

For details on the displays and functions of the ECG tab, seeWorking in the ECG
tab on page.61.

Working in the ECG tab
To display an attached ECG, open a case and click the ECG tab. For more
information, see Displaying case details on page.43.

Events pane

All defibrillator events and notes appear in chronological order on the Events pane.
You can expand events or notes in the Events pane to display additional details. For
more information, see Using the Events pane on page.63.

Use the Events toolbar to search for specific events or notes. You can also add a
note for an ECG. Use the event filter to control the display of events and notes on
the waveform. The event filter displays all possible event types and categories.
Check or uncheck them to control whether they appear.

Overview pane

TheOverview pane displays the ECGwaveform with flagged events and notes for
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each channel.

You can use theOverview toolbar to select the channel to display on the Overview
pane.

For more information, seeWorking with waveforms on page.67.

Waveforms (Channels) pane

TheWaveform pane provides amore detailed view of waveforms. Event Review
can display two waveforms (the ECG and [if recorded] the Q-CPR compression
waveform) in separate channels on this pane.

You can use theWaveforms pane to do the following:

• Add, edit, or delete notes

• Control the display of waveforms in the individual channels

• Analyze the quality of the CPR administered

Transport pane

The Transport pane at the bottom of the ECG view displays the ECG lead
information, the sweep bar time, and the cursor time relative to the sweep bar

location on the ECG. Use the Play button to play the entire ECG. For more
information, see Reviewing channel information on page.70.

If an audio recording is associated with the ECG, you can use the audio controls to
play the audio while viewing correlated events on the waveform on the Channels
pane. For more information, see Reviewing channel information on page.70.

You can also use the controls on the Transport pane to find and select events on the
waveform for review. For more information, see Reviewing channel information on
page.70.

The following illustration identifies the components of the ECG view
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Key to illustration numbers

1 Events

2 Overview

3 Channels

4 Vital Trends

5 Transport

Using the Events pane
A list of defibrillator events and notes associated with an ECG appears in an
expandable tree structure on the Events pane. Defibrillator events can include items
such as the following:

• Shocks

• Alarms

• Monitor settings

• Equipment status

• Q-CPR events
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In the Events pane, you can identify types of events, view them, search for them,
and display/hide them. You can alsomanage the notes that are attached to each
case.

Identifying types of events

Event Review displays the notes that were entered when the case was added to the
Event pane. For more information, see Documenting events on page.57.

The following icons identify event entries:

Symbol Meaning

Note: A user-input observation about the patient's status or the
responder's intervention made on the Timeline tab.

Note: A user-input observation about the patient's status or the
responder's intervention made on the ECG tab.

Shock: The delivery of therapy by the defibrillator.

Device On: The time the defibrillator was turned on or returned to use.

Device Off: The time the defibrillator was turned off.

Defibrillator alarm: An alert provided by the defibrillator. The alarm
calls attention to a patient vital sign that is beyond a preset threshold.

Error condition: An error related to the ability of the defibrillator or part
of the defibrillator to perform its intended monitoring function.

Viewing events

When you click an event in the Events pane, the sweep bar automatically moves to
the location of the event on the ECG strip on the Overview and Channels panes. You
can expand the event in the Events pane to view event details.

To view event details, in the Events pane, click Expand. next to the event you
want to view. Event details appear. You can also double-click the event label to view
details.

To expand an Events pane node

1. Click an event or event node.
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2. Click the PLUS SIGN (+).

To collapse an Events pane node

1. Click an event or event node.

2. Click theMINUS SIGN (-).

To find and view an event using the scroll bar

1. Click and drag the scroll bar down the Events pane to find an event.

2. Click the event .

The sweep bar moves to the location of the event on the waveform.

3. Double-click the event .

The event expands to display event details.

Searching for events

Use the Search .  button on the Events toolbar to search for events or notes.

To search for an event

1. Type or select the event name in the text box on the Events toolbar.

The search text can be any portion (substring) of the event name as it appears in
the event label. For example, to search for "patient age," you could type
"patient," "patient age," "age," or even just "patien."

2. Click Search. .

If the search finds an event, it appears selected in the event tree, and the sweep
bar moves to the location of the event on the waveform.

Hiding or displaying events

Use the Filter tab to display or hide events on the waveform on theOverview,
Channels, and Events panes according to criteria that you choose.

You can display or hide events either by category or by type. If you filter by category
(for example, if you filter by Q-CPR), then all event types in that category
(CPR Pads Off, CPR Intubated, etc.) are hidden as well.

By default, all events appear except CPR compression events.
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The caution icon appears on the Filter tab when there is at least one event type
or category that was filtered. See the procedure below to display some or all of these
events.

To use the event filter

1. On the Events pane, click the Filter tab.

A list of event categories appears.

2. Click Expand. next to an event category.

The event types in the selected category appear.

3. Uncheck the box for any event type or event category that you want to remove
from the display.

The following results occur:

• The event or events disappears from theOverview and Channels panes.
• The event or events disappears from the Events pane.

• The caution  icon on the Filter tab appears.

Managing notes

You can add, modify, and delete notes in the Events pane. You can also add, edit,
and delete notes directly on the ECG on theOverview or Channels pane. For more
information, seeManaging notes on the waveform on page.72.

To add a note in the Events pane

1. Click the part of the Events pane where you want the note to appear.

2. On the toolbar, click Add Note .

The Note window appears, with a table similar to the table on the Timeline tab.

3. Click in the Annotation Type field.

4. From the list of events in the pop-up window, click and complete an event the
same as when you add events on the Timeline tab.

For more information, see Documenting events on page.57.

5. Complete the fields, as appropriate.

For example, for a Reviewer Note, type Reviewer name, Reviewer title, and
Reviewer department.

If you click Custom, type the event name and unit, if appropriate.

6. Click OK.
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The note now appears on the event tree, the ECGwaveform, and the Timeline
tab.

To modify a note in the Events pane

1. Click the note you want to modify.

2. On the toolbar, click Edit Note .

3. In the Note window, modify the note.

4. Click OK.

To delete a note in the Events pane

1. Click the note you want to delete.

2. On the toolbar, click Delete Note . The note disappears from the Event pane,
the ECGwaveform, and the Timeline tab.

Viewing waveforms
You can see the entire ECG as a continuous strip on the Overview pane. It includes
markers and labels for recorded events and notes. You can point to event labels on
the ECG on theOverview pane to view event details. In the Channel view, you can
zoom in to see an ECG segment of interest.

On theOverview andWaveforms (Channels) panes, a vertical sweep bar indicates
the current ECG time. The sweep bar provides a visual cue to the current position on
the waveform. Click the ECG on theOverview pane tomove the sweep bar to the
pointer location on theWaveforms pane. For more information, seeWorking with
waveforms on page.67.

You can see a closeup view of a segment of the ECG waveform, as well as a
closeup of compression waveforms, on theWaveforms pane. The channel displays
the waveform in a grid, indicates the selected scale,and displays events and notes
with markers.

Working with waveforms
You canmanage notes on theOverview andWaveforms panes.

On theOverview pane, a dashed box (arrow, below) identifies the waveform that
appears on the Channels pane.
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To add andmanage notes on the waveform, seeManaging notes on the waveform
on page.72.

This ECG is intended only for basic rhythm identification. It is not intended for
diagnostic and ST segment interpretation,

By default, the primary defibrillator channel appears on the Overview pane.

To select a channel

1. On theOverview toolbar, click the Channel drop-down list.

2. From the list of all recorded channels, click the channel that you want to view on
theOverview pane.

To view event details on the waveform, hover themouse over the event marker on
the ECGwaveform. Event details appear in a pop-up window.

To select an event on the waveform, click on or near the event marker on the
waveform on theOverview pane. The sweep bar moves to the location of the event
on the ECGwaveform on theWaveforms pane.

Displaying and hiding channels

If the ECG has multiple channels, you can select which channels to display or hide
on the Channels pane. You can also increase the display area of the Channels pane
to accommodatemultiple channels.

To display the compressions (waveform) channel, click Expand. on the Channel
Properties tool for this channel. The channel then appears. You can also drag the
border to increase the size of the Channels pane.

6 - Working with ECGs Event Review User Guide



69

To hide a channel on the Channels pane, click Collapse. on the Channel
Properties tool for the channel you want to hide.

Arranging sections of the ECG display

You can use the pinning function to customize the display of sections in the ECG
display.

If you ever need to put the sections back to their default locations, on the
Configuration menu, click Reset Panel Layout.

"Pinning" and "unpinning" refer to the size of an ECG section. A pinned section
might look like the illustration below:

When you click the pin for the section, it is minimized; all that you see is amarker for
it at the edge of the display, as in the figure below.

Click themarker to pin it again.

Changing the display time

At the top of the Channels pane, a ruler indicates the time scale of the waveform
displayed in elapsed time or real time. Use the channels ruler to change the time
scale between elapsed time or real time.

• Real time is the actual clock time based on the Adjusted Time.

• Elapsed time is the time since the defibrillator was turned on.

The time scale appears with divisions for seconds and fractions of seconds.

If an audio clip is associated with the waveform, the channels ruler displays a
blue overlay where the audio is present, in relation to the waveforms.

To change the display time

1. Right-click the channels ruler.
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2. On the shortcut menu that appears, click one of the following time formats:

• Elapsed Time
• Real Time

The display time changes according to your selection.

Reviewing channel information
Use the transport control (shown below) to navigate through events on an ECG
waveform, play the waveform, and play an associated audio clip while reviewing the
waveform.

You can also review information about the current sweep bar and pointer locations in
an information pane at the bottom of the ECG view.

Navigating ECG events on the waveform

• If you click Next. , the sweep bar moves to the location of the next event on
the ECGwaveform and displays the event time on the information pane.

• If you click Previous. , the sweep bar moves to the location of the previous
event on the ECGwaveform and displays the event time on the information
pane.

• If you click Play , the waveform moves at the speed of real time.

Playing the ECG audio

If audio clip was recorded with the ECG, you can play the audio andmove along
(traverse) the waveform on the Channels pane. The sweep bar indicates the location
on the waveform corresponding to the current audio. You can also play and pause
the audio by pressing the spacebar if the Channels pane is currently in use. For more
information, see Using key command andmouse shortcuts on page.74.

• To play the ECG audio, click Play. . The audio clip, and the sweep bar
moves through the waveform on the Channels pane and indicates the real time
on the information pane. If a section of the ECG has no audio, you will see a
flashing indicator that displays "No audio."
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• To pause the ECG audio, click Pause. . The audio pauses, and the sweep
bar stops at the current location on the ECGwaveform.

• To change the volume of the ECG audio, drag the Volume slider to the level you
want. This adjustment is relative to the volume that you set in theWindows
audio control. If yourWindows audio is muted or the volume is very low, the
Event Review volume setting cannot override it.

• To reset the ECG audio volume to the default level, hold downCTRL and click
the Volume slider.

Viewing ECG information

The date of the ECG, and the real time and elapsed time for the sweep bar location,
appear in an information pane at the bottom of the ECG view.

The waveform type and value for the current pointer location also appears, as well as
the cursor delta time. The cursor delta time is the difference inmilliseconds between
the current pointer location on the waveform and the sweep bar location.

Tomeasure the cursor delta time, click a location on the waveform. The difference
between the pointer location and the sweep bar appears in the Cursor time field on
the information pane.

Tomeasure the waveform value, click a location on the waveform. Event Review
dynamically assigns a name to the waveform type field, according to the waveform
type or source, and displays the waveform value in the waveform value field.

Copying ECGs to the Clipboard
You can copy ECG strips to the Clipboard. You can then paste the strips into
documents created by a word processing or graphic application. Copy the ECG
strips from the ECG view.

To copy an ECG strip to the Clipboard

1. Right-click the strip in the Overview or Channels pane.

2. On themenu that appears, click Copy to Clipboard.

3. Paste the contents of the clipboard into a document.
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Managing notes on the waveform
You can add, edit, and delete notes on the waveform. You can also use the
application toolbar to add notes.

If you want to add a note that is "fixed" on the ECG waveform—that is, its time
and date do not change—use the Timeline tab. If you want to add a note whose
time and datemove according to the Adjusted "On" time, set on the
Defibrillators section of the Overview tab, use the ECGmenu.

To add a note

1. Click the waveform where you want the note to appear.

The sweep bar moves to the pointer location.

2. Use one of the followingmethods:

• On the ECGmenu, click Add Note.

• On the Events pane toolbar, click Add Note .
• Right-click the waveform to display the shortcut menu, and click Add Note.

The Note window opens, with a table similar to the table on the Timeline tab.

3. Click the Event Name field.

4. On the list of events, click and complete an event from the list the same as
when you add events on the Timeline tab.

For more information, see Documenting events on page.57.

5. Complete the fields, as appropriate.

6. Click OK.

The note now appears on the waveform, the event tree, and the Timeline tab.

To modify a note

1. On the event tree, click the note that you want to modify.

2. Use one of the followingmethods:

• On the Events pane toolbar, click Edit Note .
• Right-click the waveform to display the shortcut menu, and click Edit Note.

3. In the Note window, make your modifications to the note.

4. Click OK.
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To delete a note

1. Click the note that you want to delete.

2. Use one of the followingmethods:

• On the Events pane toolbar, click Delete Note .
• Right-click the waveform to display the shortcut menu, and click Delete

Note.

The note disappears from the waveform.

Customizing the ECG display
You can configure the display of the waveforms in theWaveforms pane according to
your preferences. You can control the display of device events, notes, and labels..

To remove ECG information from display

1. Click theWaveforms pane.

2. Use one of the followingmethods:

• Click the ECG menu.
• Right-click the ECG.

3. Click Display Items.

The display items menu opens.

4. Click the item that you want removed from display.

The item disappears from the ECG. For additional information, see Reviewing
case events on page.76.

To restore ECG information to the display

1. Click theWaveforms pane.

2. Use one of the followingmethods:

• Click the ECG menu.
• Right-click the ECG.

3. Click Display Items.

The display items menu opens.

4. Click the item that you want restored.

The item reappears in the ECG.
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Using key command and mouse shortcuts
You can use the shortcuts in the table below to completemany of the operations on
the ECG tab:

Key command shortcuts

Audio

Play/Pause audio
Click the ECGwaveform, and then press SPACEBAR.

Reset audio volume to default level
Hold downCTRL and click the Volume slider

Event tree

Expand selected event tree nodes
SHIFT + PLUS SIGN

Collapse selected event tree nodes
SHIFT + MINUS SIGN

Sweep bar

Move sweep bar one minute backward
PAGE UP

Move sweep bar one minute forward
PAGE DOWN

Move sweep bar one strip backward in the WAVEFORMS pane
SHIFT + PAGE UP

Move sweep bar one strip forward in the WAVEFORMS pane
SHIFT+PAGE DOWN

Move sweep bar to beginning of recording
HOME

Move sweep bar to end of recording
END
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Move sweep bar one second backward
LEFT ARROW

Move sweep bar one second forward
RIGHT ARROW

Move sweep bar to previous selection
UP ARROW

Move sweep bar to next selection
DOWN ARROW

Zoom

Zoom in
PLUS SIGN (+)

Zoom out
MINUS SIGN(-)

Zoom in fully
SHIFT + PLUS SIGN(+)

Zoom out fully
SHIFT + MINUS SIGN(-)
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Reviewing case details
Use the Cases navigation button to add or review case events, plus detailed
information about them, and to attach additional files to the case. For example, you
can add responder actions and observations, and followup information about the
patient.

The events and attached files appear in a table. You can change how the entries
appear.

Reviewing case events
Use the Event Log tab to view all the defibrillator events and user notes that are
associated with the ECG. The events that appear on the Timeline and ECG tabs are
in the Event Log.

In the Event Log, you can do the following:

• View details for an event

• Sort and group the defibrillator events and notes that a responder or reviewer
added to the case

• Filter events and notes to display only those that fit your selection criteria

• Print the events for the open case

To display the event log

1. On the Cases workspace, click a case to open. For more information, see
Displaying case details on page.43.

2. Click the Event Log tab.

The table that appears is a log of events for the case in the Event Review
database.

Viewing event details

To view event details, double-click an event. The details appear on the ECG tab.
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The sweep bar identifies the event. For more information, seeWorking with
waveforms on page.67.

Hiding and displaying events

You can hide or display the list of events for the open case from the shortcut menu.

To use the shortcut menu

1. Open Cases. For more information, see Displaying case details on page.43.

2. To display a list of options, use the View menu or right-click the Event Log
table.

3. Click Refresh, Expand All, or Collapse All.

To refresh, hide, and display events

• To refresh the list of events, on the View menu or shortcut menu, click Refresh.

• To hide event details, click Collapse.  to the left of the event.

• To hide all event details, on the View menu or shortcut menu, click Collapse
All.

• To display event details, click Expand.  to the left of the event.

• To display all event details, on the View menu or shortcut menu, click Expand
All.

Sorting, grouping, and filtering events

You can change the way information displays in the list of events. You can sort and
group the list of events, and you can filter them so that only the events that meet the
criteria you select appear.

For more information, seeWorking with columns on page.88, Grouping and sorting
entries on page.88, Filtering entries on page.89, and Removing filters on page.92.

Printing case events

You can print the events for the open case .

To print a list of events for the open case

1. On the Event Log tab, decide how you want to format the list before you print it.
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Formore information, see the procedures above.

2. On the File menu or toolbar, click Print.

3. On the Print menu, click Tables.

4. Click Event Log.

5. In the Print window, click the printer, page range, and number of copies.

6. Click OK.

Attaching (adding) files to a case
Use the Attachments tab tomanage the files that you attach to the open case. For
example, you canmanage a text document, a .pdf file, or a graphics file.

Use the Attachments menu to attach files, open the attachments, and remove
attached files from the case.

No attachment file can be larger than 10Mb.

To view an attachment, youmust have the associated application on your
computer. For example, to open a picture, youmust have an application that
can open graphic files.

Displaying the Attachments tab

Use the following procedure to display the Attachments tab.

To display the Attachments tab

1. On the Cases workspace, open a case . For more information, see Displaying
case details on page.43.

2. Click the Attachments tab.

A table of the files that are attached to the case appears. The table is blank
when there are no attachments in the Event Review database that are
associated with the case.

Adding and removing attachments

Use the following procedures tomanage the attachments that are associated with
the open case.
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To attach a file

1. On the Attachments menu, click Attach.

2. In the Attach File window, navigate to the file location.

3. Click Open.

Depending on the size of the file, it can take a few seconds for the file to show in
the Attachments list.

To remove an attached file

1. On the Attachments tab, click the file description in the Attachments table.

2. On the Attachments menu, click Detach.

Sorting, grouping, and filtering attachments

You can change the way information displays in the list of attached files. You can
sort and group the list of files based on the date when the file was attached to the
case, the file type, and the file name. For more information, seeGrouping and
sorting entries on page.88.

You can also decide which columns to display; seeWorking with columns on
page.88.

If you want to limit the number of entries that appear, see Filtering entries on
page.89.

A filter shows only those rows in the table that meet the criteria you select.

Hiding and displaying attachment groups

You can also hide or display the group of attachments. The View menu and shortcut
menu lists the Refresh, Expand All, and Collapse All options.

To use the shortcut menu

1. Open Cases. For more information, see Displaying case details on page.43 .

2. Click the Attachments tab.

3. Right-click the table.

4. Click Refresh, Expand All, or Collapse All.

To refresh the list of cases, on the View menu or short-cut menu, click Refresh.
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To hide the attached files in a group, click Collapse. next to the group.

To hide all event details, on the View menu or shortcut menu, click Collapse All.

To display the attached files in a group, click Expand.  next to the group.

To display all attachments, on the View menu or shortcut menu, click Expand All.

Viewing file contents

To display the contents of an attached file

Use one of the followingmethods:

• On the Attachments menu or toolbar, click Open.

• Double-click the row in the Attachments table.

The attachment opens in the associated application.

Printing the attachments in an open case

You can print the contents of the files attached to an open case when you have the
associated application installed on your computer. Open the attachment in this
associated application and print using its features.

Youmight not be able to print all attachments, such as a video clip.

You can also print the list of attachments as they appear on the Attachments tab.

To print the list of attached files

1. On the File menu or toolbar, click Print.

2. On the Print menu, clickTables.

3. In the Print window, click the printer, page range, and number of copies.

4. Click Print or OK.
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Working with reports
Use reports to evaluate the timeliness of, effectiveness of, and trends in your
emergency system response.

The first step in working with reports is to create a case. Event Review generates
the report from the case information.

The following reports are available (though not all cases include data for all reports):

Category Based on

Case Information on the tabs in Cases

Events Events recorded for each case

Full disclosure ECG All ECG information

Pre- and Post-shock ECG ECG segments surrounding each shock event

Q-CPR report card Quality of CPR

Table The current grid of information (Cases, Event Log,
Attachments, System Log); the report shows exactly
the way you have filtered, grouped, and organized
the information in the grid

You can preview, print, export, and email reports.

If you select information from a drop-down list, your choice persists the next time
you use the field. At that time, you can select another value.

Table reports have only a Print option.

To generate a report

1. Use one of the followingmethods:

• From the File menu, click Print, then Reports, and then the report you want
to print.
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• On the toolbar, click Print, then Reports, and then the report you want to
print.

A preview of the report appears.

2. If the report has multiple pages,click the first/previous/next/last page icons in
the Navigation section to see all of them.

3. If you need to find specific text in the report, click Find, type a string to search
for, specify any search options, and click Find Next.

4. In the customization tab, choose the parameters that you want to include in the
report.

5. Click the kind of output you want to generate and follow the instructions:

• To print the report, see Printing reports on page.85.
• To export the report to a file, see Exporting reports on page.85.
• To email the report, see Emailing reports on page.86.

If you import a redacted case, Event Review replaces the name and patient ID
with a series of asterisks. If the redacted age of the patient is greater than 90,
the Date of Birth field is blank and the Age field displays 90.

Working with case reports
Case reports include detailed case information based on the information collected on
the tabs in Cases. The type of report determines the parameter settings you can
specify.

You can generate the reports in the Cases category when a case is open. For
information on how to generate a report, seeWorking with reports on page.81.

After you have generated the report preview, you can choose to append all the
available case reports in one report, rather than printing each one separately. On the
Case Customization tab, check all the reports that you want to include. Then, on the
tab for each of these reports, select the parameter settings you want to include in the
report.

For more information, see the following topics:

• Printing reports on page.85

• Exporting reports on page.85

• Emailing reports on page.86
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Working with ECG reports
ECG reports are based on the ECG strip on the ECG tab in Cases. SeeWorking
with reports on page.81.

ECG Full Disclosure

The ECGFull Disclosure report includes the entire ECG.

The report uses the following parameter settings:

• Case (required)

• Grid

• Events

• Notes

• Beat labels

• Selected channels

Dashes in the report indicate periods during the report when there is no waveform
data.

Pre- and Post-shock

The Pre- and Post-shock report documents the ECG segments surrounding each
shock event.

The ECG recording begins the presenting rhythm (Presenting seconds) at the
start of the ECG, rather than at the time that the defibrillator was turned on.

The report uses the following parameter settings:

• Case (required)

• Grid

• Events

• Notes

• Beat labels

• Presenting seconds

• Closing seconds
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• Preshock seconds

• Postshock seconds

Working with Q-CPR reports
TheQ-CPR report card is based on the quality of the CPR that a patient received
during the episode. The report uses the information that appears on the ECG tab.
You can create a report card based on the CPR results frommultiple cases; each
report appears in a separate file.

You can choose whether to display the results in millimeters or inches.

You do not have to select parameter settings, and you can choose to exclude
ventilation data from the report. SeeWorking with reports on page.81.

The report displays the following information:

• Case ID and patient information

• Episode summary information

• Episode length

• Number of shocks

• Device on and off times

• Ventilation data

• Total number of ventilations

• Total ventilation times before and after intubation

• Average ventilation rate before and after intubation

• No-flow time:

• Flow time

• Average no-flow time before and after shocks

• Use 30 sec. intervals

• Defibrillation data

• Time power was on until the first shock

• Total and average analysis and shock delivery times

• Graphic representation of the quality of CPR for the episode (maximum 30
minutes from the start of the compression waveform))
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Printing reports
Before you print a report, youmust open a case and generate the report SeeWorking
with reports on page.81.

To print a report for an open case

1. From the open case, click File, then Print, then Reports, and then the report
that you want to print.

2. On the Customization tab, complete one or more parameter settings to specify
the information that the report displays.

3. Click one of the print options.

• Click Print to select a printer, number of copies, and other printing options.
When you havemade these specifications, click Print.

• Click Quick Print to send the report directly to the default printer without
making changes.

Exporting reports
You can export a report for an open case . Event Review saves a copy of the report
to a file outside of the database. You can then email the export file or add the export
file to the case on the Attachments tab.

If you frequently review a report or want to track your system’s performance,
generate the report, and then use the Export tool to save the report as a file.

To export a report

1. Generate and view the report. For more information, seeWorking with reports on
page.81.

2. On the Report Preview toolbar, click Export To.

3. Click the arrow and click the file format for the exported file.

A list of file formats that are appropriate for the type of report appears. Waveform
datamust be in PDF format.

4. Complete the parameter settings for the file format and click OK.

The Save As window opens.

Navigate to a location where you want to save this report, or accept the default.

5. In the File name field, type a name for the report.
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The Save as Type field lists the document type that you selected.

6. Click Save.

7. If you can open the file, click one of the following buttons:

• Click Yes to preview the file.
• Click No to continue.

Emailing reports
You can email the export file for a report the sameway as you email a case.

You can use the E-mail-As option or your email application to send an exported
report to another Event Review user.

Email requires that you configureMicrosoft Outlook or aMAPI-compliant email
client, and an email profile. For more information, see Emailing a case on
page.49.

To email a report

1. Generate and view the report. For more information, seeWorking with reports on
page.81.

2. On the Report Preview toolbar, click E-Mail As.

3. Click the file format for the report. Waveforms must be in PDF format.

4. Depending on the file format that you selected, complete the export options and
click OK.

The Save As window opens.

Navigate to a location where you want to save this report, or accept the default.

5. In the File name field, type a name for the report.

The Save as Type field lists the document type that you selected.

6. Click Save.

Event Review attaches the exported report file when it displays the email
window. For more information, see Emailing a case on page.49.

7. Type the email address in the To field; type any addresses for copies in the Cc
fields.

8. Click Send.
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Working with the
System Log

You can view the System Log to see the status of all Event Review activity. You
can sort, group, and filter the list of entries. A filter shows only those entries that
meet the criteria you select.

This section provides an overview of how to use the System Log .

You can change the default layout of the System Log. This change persists the next
time you use the navigation pane or workspace. For more information, see Resizing
panes and workspaces on page.26.

To display the system log

1. On the navigation pane, click the Administration navigation button.

2. On the Administration navigation pane, click System Log.

The system log appears.

The System Log lists Event Review activity. For each action, the following
information is included:

• The type of activity, for example, Information or Error

• A description of the action

• The date and time when the action occurred

• The user logon name

If a customer support representative asks you to send the System Log, on the Help
menu, click Email Customer Support and send the email message that appears.
The System log is attached to it by default.

Each time you start Event Review, the software automatically retains the last
20,000 System Log entries and clears or deletes older entries.
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Working with columns
You can customize the columns that appear on the table. You can resize the width of
a column. You can also hide or display the columns on the table and the order in
which they appear.

• To change a columnwidth, use themouse to click and hold the column border,
and then drag the border to the size you prefer.

• To size a column to fit the width of its current content, use themouse to click the
column border, and then double-click themouse.

• To change the order in which columns appear, use themouse to click and hold
the column header, and then drag the column to the left or right to a new location.

To hide or display the columns on the table

1. Right-click a column header name to display a shortcut menu.

2. Click Columns to display a list of column header names.

3. Click a check box for each column that you want to hide or display on the table.

Column headers with a check mark display on the table.

Grouping and sorting entries
In any grid, such as the Event Log and the System Log, you can arrange entries for
your convenience.

Displaying and hiding entries

Right-click any column to display a shortcut menu. The shortcut menu lists all
columns available, with check marks next to those that currently display. Click the
check boxes to display or hide any of the columns.

Sorting entries

You can click the column header to sort the list of values in ascending (1 to 9, or a to
z) or descending (9 to 1, or z to a) order.
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Grouping entries

You can group entries so as to sort them by multiple criteria. For example, you can
select a primary (major) sort by Type and a secondary (minor) sort by Description, or
a primary sort by Device and a secondary one by Event. Use the gray area above
the entries to set up groups.

If you want to create further minor sorts, you can then dragmore column headings
into the gray area to create subgroups.

To group information

1. Click a column header and drag it to the grouping area labeled Drag a Column
Header Here to Group by That Column.

The column namemoves to the grouping area, and the table displays the groups
you create.

2. Repeat step 1 as necessary to createmore groups. Each additional column
name becomes aminor sort below themajor sort that you created in step 1. To
rearrange any of these column names in the grouping area, drag them to a new
position. The table readjusts to the new order of sorts.

3. Click the column header to sort the order in which the grouped information
appears.

To ungroup information

1. Click a column header (for example, Type or Event) in the grouping area and
drag it below the table header.

If it is the only column head in the grouping area, the table then reverts to its
original organization.

If other column headers are still in the grouping area, the table readjusts to sort
according to the column heads that are still there.

Filtering entries
Use a filter to limit the number of entries that appear. A filter specifies selection
criteria for the entries that appear. Each additional criterion that you specify for the
entries further refines the subset of entries that appear. You can combine filtering
with sorting and grouping.
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Use the upper area above the entries to filter the list of entries. To set up a filter,
select a column header and specify a value to use as a criterion. To further refine the
list, set up additional criteria.

For example, youmight first filter for entries within a certain date range. Then, you
might filter these for an institution.

To filter log entries

You can click the arrow to sort the entries in ascending (1 to 9, or a to z) or
descending (9 to 1, or z to a) order.

1. Click Click Here to Add Filter Criteria.

A row for the criteria condition appears.

2. Click Choose Field and click a column name. For example, to limit the display
to entries with one specific action, click Action.

3. Click Equal and click an operator that qualifies the value for the column. You
can specify a specific value or a range of values. For a description of each
operator that specifies a value, see Comparison Operators, below.

For example, to limit the display to entries with one specific action, click Equal.

4. In the next field, click the down arrow and select a value for the column that you
selected.

5. (Optional) Click Add Criteria to add another criteria condition.

The list of entries updates and displays another criterion row.

6. Click And and select a logical operator to evaluate the new criterion in relation to
the previous criterion. For a description of each operator used to evaluate
criteria, see Logical Operators, below.

7. Repeat steps 2 through 6 for each additional criterion you want to add to the
filter.

Event Review compares the entries that meet the last condition to the previous
condition. Only the entries that meet the two conditions appear. The process
repeats for each preceding criteria condition.

Comparison operators table

You can select a comparison operator to filter a number, a date, or text. For example,
to see all entries created after June 1, 2001, click Greater Than and type
06/01/2001. You can enter a date using theMM/DD/YYYY format or click the down
arrow to choose a date from the calendar. You can filter for specific dates or for a
range of dates. You cannot filter for specific times. For the purpose of filtering, the
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log uses a time of 12:00 AM for all dates. To select a range of dates, use the
Between operator.

Use the comparison operators in the following table with these columns: User
Name, Type, Action, Description, and Date and Time:

Comparison operator Lists the entries whose values for the column ...

Equal ...are the same as the selected value.

Not equal ...are not the same as the selected value.

Greater than ...follow or are larger than the selected value.

Less than ...are preceded or are smaller than the selected value.

Greater than or equal to ...are the same, follow, or are larger than the selected
value.

Less than or equal to ...are the same, precede, or are smaller than the selected
value.

Between ...are between the first and last selected values. Use to
specify a range of dates, numbers, or text.

Not between ...are before the first selected value or after the last
selected value.

Is null ..do not exist.

Not is null ...exist.

Is empty ...do not appear.

Not is empty ...appear.

Any of ...include the selected items.

None of ...do not include the selected items.

Logical operators table

Select the logical operator from the list of operators that you want to use to compare
two criteria. Event Review outlines the criteria and connects the conditions with a
line.

Logical operator Description

And Displays the entry when the criteria in the first and the second
conditions are both met.

And not Displays the entry when the criteria in the first condition is met
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Logical operator Description

and the criteria in the second condition is not met.

Or Displays the entry when either the criteria in the first condition
or the criteria in the second condition are met.

Or not Displays the entry when the criteria in the first condition is met
or when the criteria in the second condition is not met.

Removing filters
If you filter the entries and then exit Event Review before removing the filter, the filter
settings persist; they appear the next time you use the feature.

You can return a single column to its unfiltered state or remove all the filters.

If you remove a criterion, Event Review removes it and each criterion that
appears below it.

To return a single column to its unfiltered state, click Remove Criteria. for that
criteria condition.

To remove all filters, on the first criterion row, click Remove Criteria. .

Printing System Log entries
You can print the System Log table in portrait or landscape format.

To print the System Log entries

1. On the File menu or toolbar, click Print.

2. Click Table.

3. In the Print window, in the Select Printer list, click the printer that you want to
use.

4. (Optional) Click Preferences.

5. (Optional) In the Print Preferences window, in the Orientation area, click an
orientation.
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To print the entire width of the system log table, click Landscape .

6. Click OK to close the window.

7. (Optional) Complete the fields in the Page range area.

8. Click Print or OK.
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Customer support
Philips strives to provide you with excellent customer service and technical support.
Software updates for the integrated applications are available from the application
Helpmenu. From the Help menu, click Check for Updates.

Customer support is available through email, Internet, and telephone.

Email product support is available in English only at:
eventreview.support@philips.com. In addition, if a customer support representative
asks you to send the System Log, on the Help menu, click Email with System Log
and send the email message that appears. The System log is attached to it by
default.

Internet product support is available at the following address:

http://www.philips.com/DataManagementSupport

For telephone assistance outside the United States, please call your sales
representative or local response center. See the following tables for contact
information. You can also navigate to technical support telephone numbers for data
management products at this address:

http://www.healthcare.philips.com/main/services/response_center

Region Address Telephone number

United States Philips Healthcare 3000
Minuteman Road
Andover, Massachusetts 01810-
1099

+1(800) 263-3342

Canada Philips Healthcare, a Division of
Philips Electronics Ltd.
281 Hillmount Road
Markham, Ontario, Canada L6C
2S3

+1(800) 291-6743

Authorized EU
Representative Europe,
Middle East, and Africa

Philips Medizin Systeme
Boeblingen GmbH Cardiac and
Monitoring Systems
Hewlett-Packard Strasse 2

(+49) 7031 463-2254
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Region Address Telephone number

71034 Boeblingen, Germany

Latin America Philips Medical Systems Ltda.
Rua Verbo Divino - 1400 - 7o
Andar0
04719-002 - Sao Paulo, Brazil

0800 7017789

Asia Pacific Philips Electronics Hong Kong
Ltd. 6/F, Core Building 1
1 Science Park East Avenue
Hong Kong Science Park Shatin.
New Territories, Hong Kong

+852 2821 5888

You can also navigate to technical support telephone numbers for datamanagement
products at the above addresses.

For telephone support in English only, you can call the following numbers between
9:00 AM and 5:00 PM, Pacific Time:

• (800) 263-3342, inside the United States

• +1.978.659-3332, outside the United States

Philips Response Center telephone numbers
The following table contains telephone numbers for Philips Response Centers
around the world.

Area Country Telephone number

North America Canada 800-323-2280

United States of America 800-722-9377
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Area Country Telephone number

Europe European International Sales 41 22 354 6464

Austria 01 60 101 820

Belgium French 02 525 68 80

Dutch 02 525 68 81

Finland 09- 615 80 400

France 0810 835 624

Germany 0180 3333 544

Italy 800 232100

Luxembourg +32 2 525 68 80

Netherlands 040 27 85600

Portugal 800 201766

Spain 900 180612
902 304050

Sweden 08-59 85 2530

Switzerland German 0800 80 3000

French 0800 80 3001

United Kingdom 0870 532 9741
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Area Country Telephone number

Asia and Pacific Australia 1800 251 400

China Beijing 800 810 0038

Hong Kong 852 2821 5888

Macau 0800 923

India 18004256788

Indonesia 021 794 7542

Japan 0120 381 557

Korea 080 372 7777

Seoul 02 3445 9010

Malaysia 1800 866 188

New Zealand 0800 251 400

Philippines 02 845 7875

Singapore 1800 PHILIPS
(1800-744-5477)

South Africa 011 471 6000

Thailand 02 614 3559

Taiwan 0800 005 616

Comments or suggestions?
Please send your feedback and suggestions to: eventreview.support@philips.com

Supported help
Customer support technicians provide help for the following:

• Explaining the proper use of application features and answering your questions
about how the application works

• Explaining the proper installation andmaintenance of the application

• Assisting you in selecting and configuring card readers
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Unsupported help
Customer support technicians do not provide help for the following:

• Interpreting ECG ormedical data. Please call your medical director or clinical
specialist.

• Repairing hardware. The support technicians can help you determine if you have
a hardware problem, but they cannot help you fix problems that are not related to
the Philips HeartStart application software.

• Troubleshooting defibrillators. Instead, call Philips Customer Support and ask
for defibrillator support.

• Troubleshooting non-Philips products.

Helping us help you
You can help our technicians give you good support by following these steps:

1. Call from a phone near your computer.

2. Start Event Review.

3. Have the following information:

• Windows version.
• The application version number. This is available from the Helpmenu. Click

the About option.
• A written copy of the error message text.
• The activity and task you did when the error occurred.
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Working with
defibrillators

Most of the defibrillators that Event Review supports store data on data cards (also
calledmemory cards). Depending on the defibrillator, you need a CompactFlash or
SD data card reader to transfer the data.

The HeartStart FR3 defibrillator can transfer information using a data card or a
Bluetooth connection.

The HeartStart HS1 family of defibrillators and FRx defibrillator use an infrared
connection to transfer the information.

The HeartStart MRx Monitor/Defibrillator can transfer information using the following
methods:

• A data card to transfer the information

• Defibrillators with version 9.0 or later with the Bluetooth option to transfer the
information through a Bluetooth connection

If you need help choosing a card reader, see Selecting accessories for data
transfer on page.100. The quick reference has illustrations of the various data
cards and the associated defibrillators. It can help you recognize the data cards
and select the appropriate card reader.

Supported defibrillators
You can download product owners' manuals for supported defibrillators from the
Philips support Web site;

To download products and services materials

1. Navigate to this site: http://www.philips.com/productdocs

2. Click Resuscitation/Defibrillators products.
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3. Click the defibrillator to display a page that lists the product user and service
materials.

The following table identifies themethod used to read defibrillator data. To
understand how to use themethod, click the appropriate link in the Instructions
column.

Data source Method used to read data Instructions

HeartStart FR3 Secure digital (SD) card or
Bluetooth connection

Reading FR3 series cards on page.102

Downloading an ECG using an FR3 Bluetooth
transmission on page.38

HeartStart MRx Card reader or
Bluetoothconnection

Reading HeartStart MRx cards on page.106

Downloading an ECG using an MRx Bluetooth
transmission on page.38

HeartStart FRx Infrared (IrDA) connection Downloading an ECG from an infrared
connection on page.39

HeartStart HS1 Infrared(IrDA) connection Downloading an ECG from an infrared
connection on page.39

Selecting accessories for data transfer
Before attempting data transfer from defibrillators and devices to Event Review, be
sure that you have all the accessories you need.

Defibrillators and devices vary as to whether they use data cards and card readers,
infrared connections, and/or Bluetooth connections to transfer data.

Choosing data transfer adapters and readers

If your computer did not come installed with the appropriate software or adapter for
the transfer method, you can use an adapter or reader. Use the following table to
identify the requirements for the adapter or drive that you need.

Defibrillator Data transfer method

HeartStart FR2 CompactFlash data card
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Defibrillator Data transfer method

HeartStart FR3 Custom Philips version of the SD data card

Bluetooth data transfer

HeartStart FRx Infrared data transfer

HeartStart HS1 Infrared data transfer

HeartStart MRx CompactFlash data card

Bluetooth data transfer

batch LAN data transfer

HeartStart XL ATA flash data card

Quick reference to data cards

The following table shows the defibrillators with their associated data cards.

HeartStart FR2 FR2 defibrillators use the
CompactFlash cards with the
CompactFlash card reader, or an
ATA flash-card reader with an
adapter.

HeartStart FR3 FR3 defibrillators use Philips secure
digital SD data cards, with the SD
data-card reader, or an ATA flash-
card reader with an adapter.

HeartStart MRx MRx defibrillators use CompactFlash
cards with the CompactFlash card
reader, or an ATA flash-card reader
with an adapter.

HeartStart XL XL defibrillators use ATA flash cards
with the ATA flash-card reader.
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Choosing Bluetooth accessories

HeartStart MRx and FR3 defibrillators support data transfer using Bluetooth wireless
technology.

Event Reviewwas tested with the followingWindows systems and Bluetooth
stacks:

• Windows XP orWindows 7: Microsoft Bluetooth stack (for MRx)

• Windows XP orWindows 7: Widcomm Bluetooth stack (for FR3 orMRx)

If your computer did not comewith the installed Bluetooth option, youmust use a
Bluetooth adapter that supports these stacks.

Reading FR3 series cards
The FR3 series defibrillators store information on a SD card. SD card readers are
available through your Philips sales representative or local distributor.

To read a data card

1. One end of the data card has a series of contacts. Plug this end firmly into the
card reader.

2. Check inWindows Explorer to see that the card was recognized. When
Windows recognizes the card, it assigns a drive letter to the card.

At this point, Event Review can read the data on the card.

3. If the card does not appear inWindows Explorer, remove the card from the
reader, and then insert it into the card reader again.

Retrieving FR3 data using Bluetooth
transmission

You can download data from the FR3 to the computer through a Bluetooth
transmission. Any data currently contained in the FR3 is transferred.

The Bluetooth wizard guides you through the steps necessary to accomplish the
transfer. From an open case, click Attach ECG, click Bluetooth, click HeartStart
FR3, and then click Next.

Follow the instructions from this point.
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For further information, see Downloading an ECG using an FR3 Bluetooth
transmission on page.38.

Setting up Bluetooth transmissions for the MRx
and FR3

You can transmit HeartStart MRx and HeartStart FR3 data to Event Review through
Bluetooth® wireless transmission.

Youmust have a supported adapter for Bluetooth transmission. Most
Microsoft®-compatible Bluetooth adapters, such as IOGear GBU421 (or in
Japan, the Logitec Bluetooth 3.0 adapter (LBT-13R35861A) are suitable. You
can order an adapter from your Philips representative.

To transfer the information from the defibrillator to Event Review, youmust set up
the Bluetooth transmission on the defibrillator and the receiving computer that has
Event Review installed.

Consider the following:

• If your computer is not equipped with Bluetooth, it requires a Bluetooth dongle
with a USB connector. The dongle connects the computer and the defibrillator.

• Even if your computer is equipped with Bluetooth, youmay need other
adjustments. For example, Panasonic Toughbooks have a Toshiba Bluetooth
driver, not aMicrosoft driver. This works for theMRx; for the FR3, add a
Bluetooth dongle that supports theMicrosoft orWidcomm driver.

Event summaries might contain information that could be considered Patient
Healthcare Information (PHI) or patient-identifiable data. Handle the information in
accordance with HIPAA or your local patient privacy requirements.

Bluetooth option prerequisites for the MRx and
FR3

The prerequisites for Bluetooth use are slightly different for theMRx and FR3
defibrillators.
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MRx

The Bluetooth card on the HeartStart MRx is inside of the defibrillator. Confirm that
you have a Bluetooth card installed and that the Event Summary Bluetooth
transmission feature is enabled.

For detailed information on setting up theMRx for Bluetooth transmission, see the
most current release of the following documentation:

• HeartStart MRx Instructions for Use Addendum

• HeartStart MRx M3535A, M3536A Instructions for Use

• HeartStart MRx Data Transmission Implementation Guide

FR3

Confirm that you have a Bluetooth card installed in the defibrillator.

For detailed information on setting up the FR3 for Bluetooth transmission, see the
most current release of the following documentation:

• HeartStart FR3 Instructions for Administrators

Pairing and testing the Bluetooth option with the computer:
MRx and FR3

MRx

Use this information to pair and test the Bluetooth option for HeartStart MRx.

Make sure that the application computer is turned on and that the Bluetooth
software and adapter are installed and visible or discoverable.

To pair the HeartStart MRx Bluetooth option with the computer

1. On the HeartStart MRx mainmenu, click Bluetooth Devices.

2. Click Add Device .

The defibrillator searches for your computer.
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If your computer is not listed after the search, your computer Bluetooth is not
enabled or set up correctly. Refer to the Bluetooth documentation to
troubleshoot the setup.

3. Click the name of your computer and then press Enter.

4. Type a passkey for the Bluetooth option, using the numbermenu..

The passkey is a user-defined character sequence, such as 000, or 1234. For
information on this sequence, see the documents listed in the Bluetooth option
prerequisites for theMRx and FR3 on page.103.

5. At the top of the numbermenu, click Done.

6. On your computer, immediately watch for a pop-upmessage.

7. Click the pop-upmessage.

8. Type the same Bluetooth passkey that you typed on the defibrillator in step
4.The defibrillator and the computer now have a Bluetooth connection.and you
are ready to test it.

9. Click Next and then Finish.

10. On themainmenu of theMRx, click File Transfer and then Enter.

HeartStart MRx displays the "transmission test passed" message.

11. Click Acknowledge.

12. Scroll to Exit and click Enter.

13. On themainmenu of theMRx, click Other, Data Management, and then
Acknowledge.

14. After changing into DataManagement mode, theMRx displays a list of
summary case data with themost recent incident at the top. Select the incident
that you want to transmit.

15. Click Send and then All Event Data.

16. On your computer, in the Attach ECG dialog box, watch for a display that
includes theMRx folder, and open it to see the data that has been transferred.

FR3

Pairing the Bluetooth option for the FR3 occurs automatically. Use the following
procedure to verify that this has occurred.

To verify that the FR3 Bluetooth option has paired with the computer:

1. When the FR3 is on and you have heard the voice acknowledgment, put the unit
into Administrationmode.

2. Press the option button and select wireless data transfer.
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3. On your computer, in the Attach ECG dialog box, Event Review discovers the
PIN number and displays a list of the patient cases currently on the FR3.

Reading HeartStart MRx cards
The HeartStart MRx defibrillator stores information in internal memory.

To open the information in Event Review, transfer the information from the internal
memory to an external CompactFlash card and then download it to Event Review.

Follow the instructions in the HeartStart MRx Monitor/Defibrillator Instructions for
use guide. After you transfer the information to a CompactFlash card, you can read
the card in a card reader.

CompactFlash cards and card readers are available through your Philips sales
representative or local distributor.

To read a data card

1. Remove the data card from the HeartStart MRx data card tray.

2. One end of the data card has a series of perforations. Insert this end firmly into
the card reader.

3. Check inWindows Explorer to see that the card was recognized. When
Windows recognizes the card, it assigns a drive letter to the card.

Event Review can read the data on the card.

4. If the card does not appear inWindows Explorer, remove the card from the card
reader, and then insert it into the card reader again.

Sending the MRx Bluetooth transmission
You can download a case from HeartStart MRx to the computer through a Bluetooth
transmission.

Before downloading, make sure that theMRx has been paired with your computer.
See Pairing and testing the Bluetooth option with the computer: MRx and FR3 on
page.104 for information on pairing and testing the connection.
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To make a Bluetooth transmission

1. On the HeartStart MRx, place the defibrillator in the DataManagement mode. If
necessary, use theMRx documents that are listed in Bluetooth option
prerequisites for theMRx and FR3 on page.103.

2. Click Next Item or Prev Item to navigate to the incident of your choice.

3. Scroll to Send.

4. Press Send.

5. Select the type of information that you want to transmit toEvent Review and
click Enter.

6. The first time you send a Bluetooth transmission, a popupmessage appears,
including an option to Always Allow Authorization. If you want to do this, check
the box; if you do not, the checkbox will appear every time you send a
transmission..

7. After the HeartStart MRx transmits the incident to the computer, you can attach
the ECG from the HeartStart MRx in Event Review .

For more information, see Downloading an ECG using anMRx Bluetooth
transmission on page.38.

Reading FR2 series cards
The FR2 series defibrillators store information on a CompactFlash card. Card
readers are available through your Philips sales representative or local distributor.

The FR2 series of defibrillators can use adult defibrillation pads or infant/child
reduced-energy defibrillation pads. When a user connects infant/child reduced-
energy defibrillation pads to the FR2, the FR2 delivers a reduced-energy
defibrillation shock of 50 joules (nominal).

On the Attach ECGwindow, youmust indicate to the application whether adult or
infant/child pads were used on the patient. To do this, click the FR2 Adult or FR2
Pediatric option from a shortcut menu. For more information, see Adding ECGs on
page.34.

If you have any doubt about the type of pads that the responder used, contact the
responder.

To read a data card

1. One end of the data card has a series of perforations. Plug this end firmly into
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the card reader/

2. Check inWindows Explorer to see that the card was recognized. When
Windows recognizes the card, it assigns a drive letter to the card.

Event Review can read the data on the card.

3. If the card does not appear inWindows Explorer, remove the card from the
reader, and then insert it into the card reader again.

Reading XL cards
The XL defibrillator stores information on an ATA flash card. Read the
documentation for the defibrillator to learn how to remove the card from the
defibrillator.

You can read these cards in an ATA flash card reader or a PC Card (PCMCIA)
reader. If the computer is not equipped with an adapter, you can add one as an
external or internal card reader. The external card reader plugs into the desktop USB
port.

To read a data card

1. One end of the card has a series of perforations. Insert this end firmly into the
card reader.

2. Check inWindows Explorer to see that the card was recognized. When
Windows recognizes the card, it assigns a drive letter to the card.

The Philips DataManagement Solutions application and Event Review can read
the data on the card.

3. If the card does not appear inWindows Explorer, remove the card from the card
reader, and then insert it into the card reader again.

Transferring XL+ data
The HeartStart XL+ defibrillator uses a USB data drive to transfer event summary
data. The USB data drive connects to a USB port on the computer running Event
Review.

You can export data from the XL+ defibrillator to the XL+ USB data drive using a
menu selection in the DataManagement mode. Once the data is exported, you can
transfer it to the computer running Event Review. See Adding an ECG from aUSB
port on page.37.
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To export event-summary data from the XL+ defibrillator to the USB data drive

1. Locate the USB data port on top of the XL+ defibrillator and insert the XL+ USB
data drive into it. For more information, see the HeartStart XL+ instructions for
use.

2. Confirm that you are in Data Management mode.

3. Press theMenu Select button.

The Internal Memory menu appears.

4. Use the navigation buttons to select the Export All option.

5. Press theMenu Select button to start the task.

The data is exported to the USB data drive.

Determining the HS1 and FRx case date and
time

The HS1 family of defibrillators and FRx defibrillators do not have a real-time clock
that keeps the defibrillator date and time. Instead, the defibrillator has a continuously
running timer that starts when you insert the battery. Event Review uses this timer
and the computer date and time to calculate case and event time. The timer resets
when you remove the battery. Therefore, do not remove the battery until after you
have downloaded the patient data to the application.

Each time that Event Review communicates with an HS1 and FRx defibrillator
through IrDA, it uses the date/time of the computer clock and the timer of the
HS1/FRx defibrillator to synchronize the date/time of all events and data since the
battery was last inserted. This is called the "time sync point." If Event Review does
not find a time sync point, you need to set the case start time.

The time sync point might not match the date and time of the computer by 15 to
30 seconds.
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Using infrared connections for the HS1 and
FRx

The HS1 family of defibrillators and the FRx defibrillator use an infrared (IrDA)
communications port to transfer information. For information on how to determine the
case date and time, see Determining the HS1 and FRx case date and time on
page.109.

The infrared port is located on the lower right side of the defibrillator. To transfer
information, the receiving computer must be set up for infrared communication.

Some computers have infrared ports. If the computer does not have an infrared port
or the port does not work with the defibrillator, you can add an infrared adapter.

An infrared adapter that connects to a USB port, such as the ActiSYS IR4002US
(ACT-IR4002US if you purchase it from Philips) is the recommended adapter.

Setting up an infrared adapter
OnWindows XP installations, Event Review was tested with ACTiSYS adapters.
For best results, use the IR4002US (ACT-IR4002US if you purchase it from
Philips) and follow themanufacturer’s instructions. More information is available at
the followingWeb site:

http://www.actisys.com

To set up the infrared adapter

1. Read the instructions that camewith the infrared adapter.

2. Windows XP only: Use the CD that comes with the infrared adapter to run the
driver setup program on theWindows operating system.

3. The New HardwareWizard guides you through setting up the adapter.

Setting up the infrared connection

Downloading an ECG and device history information from anHS1 or FRx
defibrillator requires an infrared connection between Event Review and the
defibrillator.
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To transfer information, youmust put the HS1 or FRx defibrillators into the
Administrationmode.

The following discussion explains how to set up each defibrillator to transfer
information. The process is similar for the HS1 family of defibrillators and the FRx
defibrillator. However, there are enough differences to warrant separate sections.

To set up the IrDA connection between an FRx defibrillator and Event Review

If the FRx does not receive a transmission within 3minutes of starting
Administrationmode, it cancels themode. At that point, youmust start over.

1. In Event Review, complete one of the following procedures:

a. Use the CaseWizard to create a case, up to the point where you see the
Attach ECG dialog box.

b. Create a case for the infrared transmission, and then (on the toolbar) click
Attach ECG file.

c. Open an existing case for the transmission, and then (on the toolbar) click
Attach ECG file.

2. Remove the pads connector.

3. If you haven't done so already, insert the battery into the defibrillator.

You will hear voice prompts to plug in pads connectors. Disregard these
prompts in this instance. Thesemessages end once you place the defibrillator in
Administrationmode. .

4. On the defibrillator, press and hold the blue Information button, and wait for
three tones.

5. Release the blue Information button.

The voicemessage announces Administration. The defibrillator enters data
transfer mode.

6. Position the defibrillator to communicate with the computer.

The defibrillator and computer should be between 4 and 24 inches apart and
aligned with each other, with an unobstructed path between them. For help
aligning the defibrillator and the computer, click the IrDA icon on the Attach
ECG window and follow screen instructions.

You can now send and receive information between the defibrillator and the
computer. The device announces transferring data.

7. When sending and receiving information is complete,plug the pads connector in
again. You can now turn off the defibrillator.

For more information, refer to the defibrillator documentation.
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To set up the IrDA connection between an HS1 defibrillator and Event Review

If the HS1 does not receive a transmission within 3minutesof starting
Administrationmode, it cancels themode. At that point, youmust start over

1. In Event Review, complete one of the following procedures:

a. Use the CaseWizard to create a case, up to the point where you see the
Attach ECG dialog box.

b. Create a case for the infrared transmission, and then (on the toolbar) click
Attach ECG File.

c. Open an existing case for the infrared transmission, and then (on the
toolbar) click Attach ECG File.

2. Remove the pads cartridge. Locate the latch at the top, and then slide the latch
to the right to release the pads cartridge.

3. If you haven't done so already, insert the battery into the defibrillator.

4. You will hear voice prompts to plug in the pads cartridge. Disregard these
prompts in this instance. Thesemessages will be silenced once you place your
defibrillator in Administrationmode. After the battery is inserted, the defibrillator
automatically turns on.

5. On the defibrillator, press and hold the blue Information button, and then wait for
three tones.

6. Release the blue button.

A voicemessage announces Administration.

7. Briefly press the blue Information button again.

The voicemessage says Mode 1.

8. Position the defibrillator to communicate with the computer.

The defibrillator and computer should be at least 12 inches apart and aligned
with each other. For help aligning the defibrillator and the computer, click the
IrDA icon on the Attach ECG window and follow screen instructions.

You can now send and receive information between the defibrillator and the
computer. The device announces sending data.

9. When sending and receiving information is complete,reinstall the pads cartridge.
You can now turn the defibrillator off.

For more information, refer to the defibrillator documentation.

Understanding voice and system messages
Defibrillators andWindows usemessages to announce the current state.
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Defibrillator voice messages

Philips designed the defibrillators to ensure that they are always ready for use in an
emergency.

Remember to insert the HS1 pads cartridge or plug in the FRx pads connector
when you finish transferring information. This will ensure that the defibrillator is
ready for use on the next patient.

At several points in the Event Review instruction, you are instructed to ignore the
defibrillator voicemessage that says "Insert the pads cartridge (for HS1)" or "No
connector installed. Plug in pads connector (for FRx)." Themessage is there to
ensure that you are aware of the defibrillator's current state. If you remove the HS1
pads cartridge or the FRx pads connector, the defibrillator is not available for use on
the patient. When the defibrillator enters the Administrationmode, themessage
stops.

You can put the FR3 into Adminmode without removing pads.

System messages

If Windows detects an active wireless device, it starts theWindows Wireless Link.
Event Review does not use this application and cannot disable it. As a result, the
Windows Wireless Link might display messages. Thesemessages do not apply to
your current task. You can ignore them.

Emailing device history data
If you ask for assistance from Philips Customer Support, youmay be asked to
retrieve the device history data from a specific defibrillator. Use the following steps
(or as directed by Customer Support) to retrieve and email this data.

To email device history data to Customer Support

1. From the Help menu, click Email Device History.

The Email Device History dialog box appears.

2. Set up the device that you are sending data from:
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a. If you are sending data from an FRx or HS1 device, put the device into
Administrationmode. For details on setting up the connection, see Setting
up the infrared connection on page.110.

b. If you are sending data from a data card from an FR2 or FR3 device, follow
the instructions from Customer Support to put the device history data file on
the card, and then insert the card into a card reader attached to your
computer.

c. If you are sending data from a Bluetooth connection on an FR3, follow the
instructions from Customer Support to put the device history data file on the
card; then turn the defibrillator on, wait for the voice prompts, put the device
into Administrationmode, press the option button, and select Wireless Data
Transfer.

3. From the list of devices, click the one that you want to send data for and click
Finish.

An email message box appears, with the device history data appearing as an
attachment.

4. Type any comments you want to add to themessage.

5. Click Send.
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Managing the database
Event Review stores the application database inMicrosoft SQL Server 2008 R2
Express Edition. This is a free version that Philips installs by default. It limits the
database size to 10GB. The number of cases that can be stored in a database of this
size varies depending on the length of captured ECGs and whether or not the file
includes audio.

The Event Review database is low-maintenance, compared tomany other
databases. Nonetheless, attention to routinemaintenance tasks will help to ensure
database integrity.

It is the database administrator’s responsibility to set up the appropriate
databasemanagement features and to check that they execute successfully.

Back up the database on a regular basis to tape or some other medium. Disaster
recovery experts recommend that you store the backup tapes somewhere safe, so
that disasters such as fire or theft cannot harm them. Without a recent backup, you
have no chance of recovery after a catastrophe, such as a disk failure or fire. Use
your organization's backup and recovery policy to set up this procedure.

For information onmigrating data from an older version of the application, see
Migrating cases from previous versions on page.115.

Migrating cases from previous versions
You canmigrate cases from Event Review 3.5 to the Event Review 4.2 database.
The Event Review 3.5 databasemay be on a different computer than the one that
Event Review 4.2 is installed on. If this is the case, youmay need assistance from
your IT specialist to make it possible to access the Event Review 3.5 database
across the network.

Migrating the data involves the following steps:

1. You identify the database from which the cases are to bemigrated—the source
database.
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2. Event Review creates a list of all the cases from the source database and
compares them (using the case ID) to the cases in the current Event Review 4.2
database (the destination database). Cases that are not already in the
destination database aremarked for migration.

3. Youmigrate themarked cases.

Use the following procedures to complete themigration.

To select and identify the source database

1. In themain workspace, click the Administration button.

2. In the Administration navigation pane, click Migrate Records from Event
Review 3.5.

A database selection dialog box appears, displaying only those computers with
the expected, well-known instance name of HeartStart and the database name
of ER35.

3. Click the appropriate source database.

4. (Recommended) To test the accessibility of the source database, click Test.

A message appears reporting the success or failure of the test.

5. Click OK to continue themigration process.

To view and confirm the list of cases to be migrated

1. Once you have selected the source database, Event Review connects to this
database and displays a list of all the cases. The ones to bemigrated have the +
sign.

2. If a case with the same case ID already exists in the destination database, the
case will not bemigrated. If you still want to migrate such a case, cancel the
migration, rename or delete the case in the destination database, and then
restart themigration process.

To migrate the cases

1. Click OK.

The datamigration begins. This takes some time, particularly if you havemany
cases.

2. If you need to cancel migration, click Cancel. You can restart themigration
process at another time. Because any already migrated cases will have the
same case ID as those in the source database, those cases will not bemigrated
again.

Themigration status of each case is logged in the System Log, including any
errors.
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The successfully migrated cases now appear in the All Records table.
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CPC and OPC
The Cerebral Performance Categories (CPC) andOverall Performance Categories
(OPC) are two scores that are used when reporting cardiac arrest. The Follow-up tab
uses these categories.

This section explains the scores for each category.

Cerebral performance categories table

Score Description

1 Good cerebral performance: Conscious. Alert, able to work and lead a
normal life. May have minor psychological or neurological deficits (mild
dysphasia, nonincapacitating hemiparesis, or minor cranial nerve
abnormalities).

2 Moderate cerebral disability: Conscious. Sufficient cerebral function for
part-time work in sheltered environment or independent activities of daily
life (dressing, traveling by public transportation, and preparing food). May
have hemiplegia, seizures, ataxia, dysarthria, dysphasia, or permanent
memory or mental changes.

3 Severe cerebral disability: Conscious. Dependent on others for daily
support because of impaired brain function (in an institute or at home with
exceptional family effort). At least limited cognition; includes a wide range
of cerebral abnormalities from ambulatory with severe memory disturbance
or dementia precluding independent existence to paralytic and able to
communicate only with eyes, as in locked-in syndrome.

4 Coma, vegetative state: Not conscious. Unaware of surroundings, no
cognition. No verbal or psychological interactions with environment.

5 Death: Certified brain dead by traditional criteria.

Overall performance categories table

Score Description

1 Good overall performance: Healthy, alert, capable of normal life. Good
cerebral performance (CPC1) plus no or only mild functional disability from
noncerebral organ system abnormalities.
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Score Description

2 Moderate overall disability: Conscious. Moderate cerebral disability alone
(CPC2) or moderate disability from noncerebral system dysfunction alone
or both. Performs independent activities of daily life (dressing, traveling,
and food preparation). May be able to work part-time in sheltered
environment but disabled for competitive work.

3 Severe overall disability: Conscious. Severe cerebral disability alone
(CPC3) or severe disability from noncerebral organ system dysfunction
alone or both. Dependent on others for daily support.

4 Coma, vegetative state: Not conscious. Unaware of surroundings, no
cognition. No verbal or psychological interactions with environment.

5 Death: Certified brain dead by traditional criteria.
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Glasgow Coma score
TheGlasgow Coma score is a score given to head trauma victims based on the
Glasgow ComaScale (GCS). The total score is based on examination of eye
opening, verbal output, andmotor (movement) responses to different modalities and
intensity of stimulation. You give each of these three attributes a score, and then
Event Review totals the three scores.

The choices in the GCS Total field are:

0 (3) (total up to 3)

1 (4-5) (total from 4 to 5)

2 (6-8) (total from 6 to 8)

3 (9-12) (total from 9 to 12)

4 (13-15) (total from 13 to 15)

Unknown

A score of “unknown” indicates that one or more response scores do not have
an entry or have an entry of “unknown.”

Eye opening Verbal output Motor (movement) responses

Score Finding Score Finding Score Finding

6 Obeys commands
or
Spontaneous or
purposeful

Patient follows
commands

5 Oriented
or
Coos or babbles

Normal, fluent,
appropriate speech

5 Purposeful
or
Withdrawal from touch

Patient locates pain on
his body
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Eye opening Verbal output Motor (movement) responses

4 Spontaneous

Eyes open without
stimulation

4 Confused
or
Irritable and continually
crying

Confused but fluent
speech

4 Withdraws from pain

Patient pulls away from
pain

3 To voice

Eye opening to loud
noise

3 Inappropriate
or
Cries to pain

Mumbling, occasional
word recognizable

3 Flexion to pain
or
Abnormal flexion to
pain

Patient flexor postures

2 To pain

Eye opening to pain
only

2 Incomprehensible
or
Moans to pain

Vocalizations but not
verbalizations (no
words)

2 Extension to pain

Patient extensor
postures

1 None

No eye opening

1 None

No vocalization or
verbalization

1 None

No motor response 
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Glossary
Administration

Administrationmode allows you to apply or change configuration settings in a
HeartStart supported defibrillator, and also allows an administrator to view
HeartStart Configure activities.

Administration mode

A setting on HeartStart defibrillators that allows the defibrillator to send and receive
information.

Administration pane

The Administration pane allows you to view system log entries for the computer
running HeartStart Configure.

AED

Stands for Automated External Defibrillator. A defibrillator that automatically
performs rhythm analysis of the patient’s surface electrocardiogram.

All Configurations

A feature in the Saved Configurations pane that allows you to view all configurations
that are available for viewing and editing in HeartStart Configure.

Archive

To store or save information.

Attend to Patient Period

A period following a no shock Advised (NSA) decision during which the responder
may perform CPR, if needed, or otherwise attend to the patient.

BLS

Basic Life Support

Bluetooth wireless transmission
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Use of an optional FR3 Bluetooth wireless technology transceiver module to transfer
a configuration from aHeartStart FR3 defibrillator to a Bluetooth-enabled computer.

Bluetooth®

A short-range wireless technology that uses radio links between devices such as
defibrillators and computers, mobile computers, mobile phones, and other portable
devices.

Bystander CPR

The attempt to perform basic CPR by someone who is not part of an organized
emergency response system. Typically, this person witnessed the arrest. In certain
situations, physicians, nurses, and paramedics may perform bystander CPR.

Card reader

Hardware that reads information from a data card.

CFG

Stands for configuration file. This binary file extension type is used for a HeartStart
FR3 configuration file.

Configuration

A file that sets the behavior of a defibrillator.

Configuration Tasks

A task pane in HeartStart Configure that allows you to create defibrillator
configurations per American Heart Association (AHA) guidelines, and set time, date,
and language options for the HeartStart FR3 defibrillator.

Configurations (feature)

A feature set that allows you to configure, manage, and review information about a
defibrillator configuration. HeartStart Configure identifies each configuration based
on the type, name and the date and time of the configuration. This allows you to list
configurations based on a variety of values.

Configurations pane

The Configurations pane allows you to view andmanage supported defibrillator
configurations.

CPR
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Stands for Cardiopulmonary Resuscitation. A technique for providing artificial
respiration and heart compressions tomaintain life in a victim of Sudden Cardiac
Arrest (SCA).

DAT

Stands for data file. This binary file format is used by Event Review 3.5 and Event
Review Pro 3.5 for HeartStart FRx and HS1 defibrillator configurations.

Data Card

A computer storage device used for recording and storing information. Some
HeartStart defibrillators use data cards to record configuration, ECG, and audio
information.

Defibrillator event

Information received from a defibrillator. Examples are alarms, shocks,
measurements, and error conditions.

Device

A generic term used for defibrillators and data cards.

ECG

Stands for electrocardiogram. The electrical rhythm of the heart as detected through
defibrillator pads.

EMS

Stands for Emergency Medical Services.

Error

Describes a system error or an erroneous input by the user.

Export

Saving a configuration as a file for use on another computer running HeartStart
Configure. This is typically done to share a configuration with other users or to back
up a configuration.

Feature

A link or button within the HeartStart Configure task pane that allows you to
complete a task.
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Fibrillation

A disturbance of the normal heart rhythm that results in chaotic, disorganized
activity that cannot effectively pump blood. Ventricular fibrillation (fibrillation in the
lower chambers of the heart) is themost common cause of sudden cardiac arrest.

FR3

A HeartStart compact, battery-powered automated external defibrillator (AED)
designed for use by trained responders to treat ventricular fibrillation (VF), themost
common cause of sudden cardiac arrest (SCA).

FRx

A HeartStart compact, battery-powered automated external defibrillator (AED)
designed for use by trained responders to treat ventricular fibrillation (VF), themost
common cause of sudden cardiac arrest (SCA).

Getting Started

A task pane in HeartStart Configure that allows you to navigate to online help,
selecting accessories, and check for software updates.

HS1

A HeartStart compact, battery-powered automated external defibrillator (AED) that
is designed for simple and reliable operation by minimally trained users to treat
ventricular fibrillation (VF), themost common cause of sudden cardiac arrest (SCA).

HTTP

Stands for Hypertext Transfer Protocol. The set of rules for exchanging files (text,
graphic images, sound, video, and other multimedia files) on theWorldWideWeb.

Import

Opening a defibrillator configuration file that is not stored in HeartStart Configure,
and was created by another user on another installation of HeartStart Configure.

Incident

The series of events involved in treating a patient with a defibrillator.

Information

Details action and events of an end-user using HeartStart Configure.

Language Card
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A secure digital (SD) card that can be purchased separately for the HeartStart FR3
defibrillator model. It contains languages used by the local culture. You can either
change the primary language, or set a second language for bilingual operation.

License Manager

The LicenseManager allows you to type in your registration key to activate
HeartStart Configure software.

Navigation pane

Use the navigation pane to navigate to workspaces and to select a defibrillator and
perform defibrillator configuration tasks.

NSA

Stands for no shock advised. A decision that is made by the defibrillator based on
analysis of the patient’s heart rhythm. The defibrillator will not deliver a shock in this
mode.

PEA

Pulseless Electrical Activity.

PR

Perfusing Rhythm.

PST

For Periodic Self Test. A self-administered test mode that a HeartStart defibrillator
runs to ensure that all defibrillator components are functional and work properly. Test
results are Pass, Warning, or Call customer support.

Recorded “On” Time

The date and time the responder turned on the defibrillator.

Save

Adding a new configuration the information and its associated details to the
HeartStart Configure dataset for reuse later on other defibrillators in order to
standardize defibrillator behavior.

Saved configurations
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The area of the Navigation pane where configurations can be viewed and filtered
based on supported defibrillator type.

Shock series

Also called shock stack. A sequence of one or more shocks, each separated by no
more than a preset interval. After completion of a shock series, the defibrillator
automatically provides a CPR protocol.

SMART analysis

The proprietary algorithm used by the FR3 to analyze the patient’s heart rhythm and
determine whether a shock is advised.

Smart CPR

A configurable feature that, either automatically or by manual selection, enables a
CPR interval before rhythm analysis and shock decision for patients with a
shockable rhythm.

System log

The system log lists all monitored application activity. Use the system log to review
application usage.

Task wizard

A software feature that guides the user through a task.

URL

Stands for Uniform Resource Locator. An address for a resource on the Internet.
URLs are used by Web browsers to locate Internet resources. A URL specifies the
protocol to be used in accessing the resource (such as http: for aWorldWideWeb
page or ftp: for an FTP site), the name of the server on which the resource resides
(such as //www.whitehouse.gov), and, optionally, the path to a resource (such as an
HTML document or a file on that server).

Workspace

The pane to the right of the HeartStart Configure navigation pane. It displays the
active window for entering and viewing information.

XML
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Stands for eXtensible Markup Language. This file format has a set of rules for
encoding documents in machine-readable form. It is used for HeartStart Configure
3.0 configuration files. A HeartStart Configure 3.0 file is exported in the XML file
format.
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